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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.

• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on the
right side of the tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a service representative.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before proceeding.
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CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections, such as
the fax feature, power cord, or telephone, during a lightning storm.

SAVE THESE INSTRUCTIONS.
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Learning about the printer

Finding information about the printer
What are you looking for? Find it here

Initial setup instructions:

• Connecting the printer

• Installing the printer software

Setup documentation—The setup documentation came
with the printer and is also available at
http://support.lexmark.com.

Additional setup and instructions for using the printer:

• Selecting and storing paper and specialty media

• Loading paper

• Configuring printer settings

• Viewing and printing documents and photos

• Setting up and using the printer software

• Configuring the printer on a network

• Caring for and maintaining the printer

• Troubleshooting and solving problems

User's Guide and Quick Reference Guide—The guides are
available on the Documentation CD.

For more information, visit
http://support.lexmark.com.

Instructions for:

• Connecting the printer to an Ethernet network

• Troubleshooting printer connection problems

Networking Guide—Open the Software CD, and then look
for Printer and Software Documentation under the Pubs
folder. From the list of publications, click the Networking
Guide link.

Help using the printer software Windows or Mac Help—Open a printer software program
or application, and then click Help.

Click ?  to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.
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What are you looking for? Find it here

The latest supplemental information, updates, and customer
support:

• Documentation

• Driver downloads

• Live chat support

• E‑mail support

• Voice support

Lexmark Support Web site—
http://support.lexmark.com

Note: Select your country or region, and then select
your product to view the appropriate support site.

Support telephone numbers and hours of operation for
your country or region can be found on the Support Web
site or on the printed warranty that came with your
printer.

Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

• Machine Type number

• Serial number

• Date purchased

• Store where purchased

Warranty information Warranty information varies by country or region:

• In the U.S.—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

• In other countries and regions—See the printed
warranty that came with your printer.

Selecting a location for the printer
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
hardware options, then leave enough room for them also. It is important to:

• Set up the printer near a properly grounded and easily accessible electrical outlet.

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical Committee
156 standard.

• Provide a flat, sturdy, and stable surface.

• Keep the printer:

– Clean, dry, and free of dust.

– Away from stray staples and paper clips.

– Away from the direct airflow of air conditioners, heaters, or ventilators.

– Free from direct sunlight and humidity extremes.

• Observe the recommended temperatures and avoid fluctuations.

Ambient temperature 16 to 32°C (60 to 90°F)

Storage temperature ‑20 to 40°C (‑4 to 104°F)

• Allow the following recommended amount of space around the printer for proper ventilation:
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5

1

2

3

4

1 Right side 30 cm (12 in.)

2 Front 51 cm (20 in.)

3 Left side 20 cm (8 in.)

4 Rear 20 cm (8 in.)

5 Top 30 cm (12 in.)

Printer configurations
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

M1145dn printer model

1
2 3

8

5

6

7

4

1 Printer control panel

2 Paper stop

3 Standard bin

4 Front door release button
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5 Controller board access door

6 100‑sheet multipurpose feeder

7 Standard 250‑sheet tray

8 Optional 250‑ or 550‑sheet trays

Using the printer control panel

1 2 3 4 5 6 7

89
10111213

Use the To

1 Display • View the printer status and messages.

• Set up and operate the printer.

2 Left arrow button Scroll to the left.

3 Select button • Select menu options.

• Save settings.

4 Up arrow button Scroll up.

5 Right arrow button Scroll to the right.

6 Keypad Enter numbers, letters, or symbols.

7 Sleep button Enable Sleep mode or Hibernate mode.

The following actions wake the printer from Sleep mode:

• Pressing any hard button

• Opening a tray or the front door

• Sending a print job from the computer

• Performing a power‑on reset using the main power switch

• Attaching a device to the USB port

8 USB port Connect a flash drive to the printer.

Notes:

• Only the front USB port supports flash drives.

• This feature is available only in select printer models.

9 Stop or cancel button Stop all printer activity.

10 Back button Return to the previous screen.
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Use the To

11 Down arrow button Scroll down.

12 Home button Go to the home screen.

13 Indicator light Check the status of the printer.

Understanding the colors of the Sleep button and indicator
lights
The colors of the Sleep button and indicator lights on the printer control panel signify a certain printer status or condition.

Indicator light color and its corresponding printer status

Indicator light Printer status

Off The printer is off or in Hibernate mode.

Blinking green The printer is warming up, processing data, or printing.

Solid green The printer is on, but idle.

Blinking red The printer requires user intervention.

Sleep button light color and its corresponding printer status

Sleep button light Printer status

Off The printer is off, idle or in Ready state.

Solid amber The printer is in Sleep mode.

Blinking amber The printer is entering or waking from Hibernate mode.

Blinking amber for 0.1 second, then goes
completely off for 1.9 seconds in a slow,
pulsing pattern

The printer is in Hibernate mode.
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Additional printer setup

Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have other devices attached to the printer, then turn them
off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

Available internal options
• DDR3 DIMM

• Flash memory

– Fonts

– Firmware

• Forms Barcode

• Prescribe

• IPDS

• Printcryption

• Hard disk*

• Internal Solutions Ports (ISP)*

– Parallel 1284‑B interface

– MarkNet N8130 10/100 fiber interface

– RS‑232‑C serial interface

* This internal option is available only in the M3150de printer model.
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Accessing the controller board
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Open the controller board access door.

2 Use the following illustration to locate the appropriate connector.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or
connectors.

2

1

1 Memory card connector

2 Option card connector
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Installing an optional card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have other devices attached to the printer, then turn them
off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unpack the optional card.

Warning—Potential Damage: Avoid touching the connection points along the edge of the card.

3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

2

1
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4 Push the card firmly into place as shown in the illustration.

Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.

Note: The entire length of the connector on the card must touch and be flushed against the controller board.

5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, it may be necessary to manually add
the options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 21.

Installing a memory card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

Additional printer setup 16



An optional memory card can be purchased separately and attached to the controller board.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 14.

2 Unpack the memory card.

Warning—Potential Damage: Do not touch the connection points along the edge of the card. Doing so may
cause damage.

3 Align the notch (1) on the memory card with the ridge (2) on the connector.

1

2

4 Push the memory card straight into the connector and forward into the controller board wall until it clicks into
place.

1 2

5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, you may need to manually add the options
in the printer driver to make them available for print jobs. For more information, see “Updating available options in
the printer driver” on page 21.
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Installing hardware options

Installing optional trays
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Turn off the printer using the power switch, and then unplug the power cord from the electrical outlet.

2

1

2 Unpack the tray, and then remove all packing materials.

3 Pull the tray completely out of the base.

4 Remove any packing material from inside the tray.

5 Insert the tray into the base.

6 Place the tray near the printer.

7 Align the printer with the tray, and then lower the printer into place.

Note: Optional trays lock together when stacked.
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8 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.

1

2

Note: When the printer software and any hardware options are installed, you may need to manually add the
options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 21.

To uninstall the optional trays, slide the latch on the right side of the printer toward the front of the printer until
it clicks into place, and then remove stacked trays one at a time from the top to the bottom.

Attaching cables
Connect the printer to the computer using a USB or parallel cable, or to the network using an Ethernet cable.

Make sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer

• The appropriate parallel cable with the parallel port
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• The appropriate Ethernet cable with the Ethernet port

Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the area shown
while actively printing. Loss of data or a malfunction can occur.

1

2

3

4

5 6

7

Use the To

1 USB port Attach an optional wireless network adapter.

2 USB printer port Connect the printer to a computer.

3 Ethernet port Connect the printer to an Ethernet network.

4 Parallel port

Note: This port is available only in select printer models.

Connect the printer to a computer.

5 Power switch Turn on or turn off the printer.

6 Printer power cord socket Connect the printer to an electrical outlet.

7 Security slot Attach a lock that will secure the printer in place.

Setting up the printer software

Installing the printer software

Notes:

• If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

• Close all open software programs before installing the printer software.

• For Macintosh users, you may download all the drivers and utilities from our Web site.
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1 Obtain a copy of the software installer package.

• From the Software CD that came with your printer

• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.

Wait for the installation dialog to appear.

If you are using the Software CD and the installation dialog does not appear, then do the following:

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type D:\setup.exe > OK.

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe.

c Press Enter, or click OK.

Note: D is the letter of your CD or DVD drive.

3 Click Install, and then follow the instructions on the computer screen.

Updating available options in the printer driver
When any hardware options are installed, you may need to manually add the options in the printer driver to make
them available for use.

For Windows users

1 Open the printers folder.

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type control printers > OK

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Depending on your device, do either of the following:

• Press and hold the printer you want to update.

• Right‑click the printer you want to update.
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3 From the menu that appears, do either of the following:

• For Windows 7 or later, select Printer properties.

• For earlier versions, select Properties.

4 Click the Configuration tab.

5 Do either of the following:

• Click Update Now ‑ Ask Printer.

• Under Configuration Options, manually add any installed hardware options.

6 Click Apply.

For Macintosh users

1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan > select your printer > Options & Supplies > Driver

• System Preferences > Print & Fax > select your printer > Options & Supplies > Driver

2 Add any installed hardware options, and then click OK.

Networking
Notes:

• Purchase a MarkNetTM N8352 wireless network adapter first before setting up the printer on a wireless network.
For information on installing the wireless network adapter, see the instruction sheet that came with the
adapter.

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP), Wi-Fi
Protected Access (WPA), WPA2, and 802.1X - RADIUS are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you begin:

Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing the
printer.

• A valid, unique IP address for the printer to use on the network

• The network gateway

• The network mask

• A nickname for the printer (optional)

Note: A printer nickname can make it easier for you to identify your printer on the network. You can choose to
use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer can
physically connect to the network. Use a new network cable when possible to avoid potential problems caused by a
damaged cable.
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Installing the printer on an Ethernet network

For Windows users

1 Obtain a copy of the software installer package.

• From the Software CD that came with your printer

• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.

Wait for the installation dialog to appear.

If you are using the Software CD and the installation dialog does not appear, then do the following:

In Windows 8

From the Search charm, type run, and then navigate to:

Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type D:\setup.exe.

c Press Enter, or click OK.

Note: D is the letter of your CD or DVD drive.

3 Click Install, and then follow the instructions on the computer screen.

4 Select Ethernet connection, and then click Continue.

5 Attach the Ethernet cable when instructed to do so.

6 Select the printer from the list, and then click Continue.

Note: If the configured printer does not appear in the list, then click Modify Search.

7 Follow the instructions on the computer screen.

For Macintosh users

1 Allow the network DHCP server to assign an IP address to the printer.

2 Obtain the printer IP address either:

• From the printer control panel

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then finding the TCP/IP section

Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.

3 Install the printer driver on the computer.

a Download the driver at http://support.lexmark.com.

b Double‑click the installer package for the printer, and then follow the instructions on the computer screen.

c Select a destination, and then click Continue.
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d From the Easy Install screen, click Install.

e Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when installation is complete.

4 Add the printer.

• For IP printing:
a From the Apple menu, navigate to either of the following:

– System Preferences > Print & Scan

– System Preferences > Print & Fax
b Click +.
c Click the IP tab.
d Type the printer IP address in the address field, and then click Add.

• For AppleTalk printing:

Notes:

– Make sure AppleTalk is activated on your printer.

– This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:

System Preferences > Print & Fax
b Click +, and then navigate to:

AppleTalk > select your printer > Add

Preparing to set up the printer on a wireless network

Notes:

• Make sure your wireless network adapter is installed in your printer and working properly. For more
information, see the instruction sheet that came with the wireless network adapter.

• Make sure your access point (wireless router) is turned on and is working properly.

Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.

• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.

• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.

Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

• Security Method—There are four basic options for Security Method:

– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS
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If you are installing the printer on an 802.1X network, then you may need the following:

• Authentication type

• Inner authentication type

• 802.1X user name and password

• Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: We do not recommend using an unsecured wireless network.

Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point, or contact
your system support person.

– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation that
came with the access point, see the Embedded Web Server associated with the access point, or consult your
system support person.

Connecting the printer using the Wireless Setup Wizard
Before you begin, make sure that:

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

• The Ethernet cable is disconnected from the printer.

• Active NIC is set to Auto. To set this to Auto, navigate to either of the following:

–  > Settings >  > Network/Ports >  > Active NIC >  > Auto > 

–  > Network/Ports > Active NIC > Auto

Note: Make sure to turn off the printer, then wait for at least five seconds, and then turn the printer back on.

1 Depending on your printer model, navigate to either of the following:

•  > Settings >  > Network/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >

 > Wireless Connection Setup > 

•  > Network/Ports > Network [x] > Network [x] Setup > Wireless > Wireless Connection Setup

2 Select a wireless connection setup.

Use To

Search for networks Show available wireless connections.

Note: This menu item shows all broadcast secured or unsecured SSIDs.

Enter a network name Manually type the SSID.

Note: Make sure to type the correct SSID.

Wi‑Fi Protected Setup Connect the printer to a wireless network using Wi‑Fi Protected Setup.
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3 Follow the instructions on the printer display.

Connecting the printer to a wireless network using Wi‑Fi Protected Setup
Before connecting the printer to a wireless network, make sure that:

• The access point (wireless router) is Wi‑Fi Protected Setup (WPS) certified or WPS‑compatible. For more
information, see the documentation that came with your access point.

• A wireless network adapter is installed in your printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

Using the Push Button Configuration Method

1 Depending on your printer model, navigate to either of the following:

•  > Settings >  > Networks/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >

 > Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start Push Button Method > 

•  > Network/Ports > Network [x] > Network [x] Setup > Wireless > Wireless Connection Setup > Wi‑Fi
Protected Setup > Start Push Button Method

2 Follow the instructions on the printer display.

Using the Personal Identification Number (PIN) Method

1 Depending on your printer model, navigate to either of the following:

•  > Settings >  > Networks/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >

 > Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start PIN Method > 

•  > Network/Ports > Network [x] > Network [x] Setup > Wireless > Wireless Connection Setup > Wi‑Fi
Protected Setup > Start PIN Method

2 Copy the eight‑digit WPS PIN.

3 Open a Web browser, and then type the IP address of your access point in the address field.

Notes:

• The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are accessing a proxy server, then temporarily disable it to load the Web page correctly.

4 Access the WPS settings. For more information, see the documentation that came with your access point.

5 Enter the eight‑digit PIN, and then save the setting.

Connecting the printer to a wireless network using the Embedded Web Server
Before you begin, make sure that:

• Your printer is connected temporarily to an Ethernet network.

• A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Network/Ports > Wireless.

3 Modify the settings to match the settings of your access point (wireless router).

Note: Make sure to enter the correct SSID, security method, preshared key or passphrase, network mode, and
channel.

4 Click Submit.

5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then turn the
printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is Connected.

Verifying printer setup

Printing a menu settings page
Print a menu settings page to view the current menu settings and to verify if the printer options are installed correctly.

From the printer control panel, navigate to:

 > Settings > Reports >  > Menu Settings Page > 

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default settings.
Settings saved from the menus replace the factory default settings as user default settings. A user default setting
remains in effect until you access the menu again, select another value, and save it.

Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:

 > Settings > Reports >  > Network Setup Page > 

Note: If an optional internal print server is installed, then Print Network [x] Setup Page appears.

2 Check the first section of the network setup page, and confirm that the status is Connected.

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be malfunctioning.
Consult your system support person for a solution, and then print another network setup page.
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Loading paper and specialty media
The selection and handling of paper and specialty media can affect how reliably documents print. For more information,
see “Avoiding jams” on page 120 and “Storing paper” on page 45.

Setting the paper size and type
1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Paper Size/Type > 

2 Press the up or down arrow button to select the tray or feeder, and then press .

3 Press the up or down arrow button to select the paper size, and then press .

4 Press the up or down arrow button to select the paper type, and then press  to change the settings.

Configuring Universal paper settings
The Universal paper size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus.

Notes:

• The smallest Universal paper size is 6 x 127 mm (3 x 5 inches), and is supported only from the multipurpose
feeder.

• The largest Universal paper size is 216 x 355.6 mm (8.5  x 14 inches), and is supported from all paper sources.

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Universal Setup >  > Units of Measure >  > select a unit of

measure > 

2 Select Portrait Width or Portrait Height, and then press .

3 Press the left or right arrow button to change the setting, and then press .

Using the standard bin and paper stop
The standard bin holds up to 150 sheets of 20‑lb paper. It collects prints facedown. The standard bin includes a paper
stop that keeps paper from sliding out the front of the bin as it stacks.
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To open the paper stop, pull it so that it flips forward.

Note: Close the paper stop when moving the printer to another location.

Loading trays
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray completely.

Note: Do not remove trays while a job prints or while Busy appears on the printer display. Doing so may cause
a jam.

A4

LTR

EXEC

B5

A5

A6
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2 Squeeze and then slide the width guide tab to the correct position for the size of the paper you are loading.

A4

LTR
EXEC

B5

A
5

2

1 LTRLGL EXECA4

B5

A5

3 Squeeze and then slide the length guide tab to the correct position for the size of the paper you are loading.

A4

LTR
EXEC

B5

A
5

LTRLGL
A4

EXEC

B5

A5

A6

2

1

Notes:

• For some paper sizes like letter, legal, and A4, squeeze and slide the length guide tab backward to
accommodate their length.
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• When loading legal‑size paper, the length guide extends beyond the base leaving the paper exposed to dust.
To protect the paper from dust, you can purchase a dust cover separately. For more information, contact
customer support.

• If you are loading A6-size paper in the standard tray, then squeeze and then slide the length guide tab
toward the center of the tray to the A6‑size position.

• Make sure the width and length guides are aligned with the paper size indicators on the bottom of the tray.

A
4

LTREX
EC

B5

A
5

LTRLGL
A4

EXEC

B5

A5

A6

4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.
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5 Load the paper stack.

Notes:

• Load with the printable side facedown when using recycled or preprinted paper.

• Load prepunched paper with the holes on the top edge toward the front of the tray.

• Load letterhead facedown, with the top edge of the sheet toward the front of the tray. For two‑sided
printing, load letterhead faceup with the bottom edge of the sheet toward the front of the tray.

• Make sure the paper is below the maximum paper fill indicator located on the side of the width guide.
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6 Insert the tray.

7 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper loaded in
the tray.

Note: Set the correct paper size and type to avoid paper jams and print quality problems.

Loading the multipurpose feeder
Use the multipurpose feeder when printing on different paper sizes and types or specialty media, such as card stock,
transparencies, paper labels, and envelopes. You can also use it for single‑page print jobs on letterhead.

1 Open the multipurpose feeder.

1

2
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a Pull the multipurpose feeder extender.

b Pull the extender gently so that the multipurpose feeder is fully extended and open.

2 Squeeze the tab on the left width guide, and then move the guides for the paper you are loading.

2

1
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3 Prepare the paper or specialty media for loading.

• Flex sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

• Hold transparencies by the edges. Flex the stack of transparencies back and forth to loosen them, and then fan
them. Straighten the edges on a level surface.

Note: Avoid touching the printable side of the transparencies. Be careful not to scratch them.

• Flex the stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a level
surface.

4 Load the paper or specialty media.

Notes:

• Do not force paper or specialty media into the multipurpose feeder.

• Make sure the paper or specialty media is below the maximum paper fill indicator located on the paper
guides. Overfilling may cause paper jams.
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• Load paper, transparencies, and card stock with the recommended printable side faceup and the top edge
entering the printer first. For more information on loading transparencies, see the packaging that the
transparencies came in.

Note: When loading A6‑size paper, make sure the multipurpose feeder extender rests lightly against the
edge of the paper so that the last few sheets of paper remain in place.
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• Load letterhead faceup with the top edge entering the printer first. For two‑sided (duplex) printing, load
letterhead facedown with the bottom edge entering the printer first.

• Load envelopes with the flap on the left side facedown.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self‑stick adhesives. These envelopes may severely damage the printer.

5 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper or specialty
media loaded in the multipurpose feeder.

Linking and unlinking trays

Linking and unlinking trays
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel in the TCP/IP section under the Network/Ports
menu. The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu.
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3 Change the paper size and type settings for the trays you are linking.

• To link trays, make sure the paper size and type for the tray match that of the other tray.

• To unlink trays, make sure the paper size or type for the tray does not match that of the other tray.

4 Click Submit.

Note: You can also change the paper size and type settings using the printer control panel. For more information,
see “Setting the paper size and type” on page 28.

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the printer.
The temperature of the fuser varies according to the specified paper type. Printing issues may occur if settings are
not properly configured.

Creating a custom name for a paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Select a custom name, and then type a new custom paper type name.

4 Click Submit.

5 Click Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Select a custom name, and then type a new custom paper type name.

3 Press .

4 Press Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Assigning a custom paper type name

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Type a name for the paper type, and then click Submit.

4 Select a custom type, and then verify that the correct paper type is associated with the custom name.

Note: Plain Paper is the factory default paper type for all user‑defined custom names.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Type a name for the paper type, and then press .

Assigning a custom paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Types.

3 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Types

2 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

3 Press .
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Paper and specialty media guide

Using specialty media

Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly impact print quality. Print samples on the card stock being considered for use before
buying large quantities.

When printing on card stock:

• Make sure the Paper Type is Card Stock.

• Select the appropriate Paper Texture setting.

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or
other paper handling problems.

• Check with the manufacturer or vendor to ensure that the card stock can withstand temperatures up to 240°C
(464°F) without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure that the
envelopes can withstand temperatures up to 230°C (446°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For best performance, use envelopes made from 90‑g/m2 (24‑lb bond) paper or 25% cotton. All‑cotton envelopes
must not exceed 70‑g/m2 (20‑lb bond) weight.

• Use only new envelopes from undamaged packages.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position
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– Have bent corners

– Have rough, cockle, or laid finishes

• Adjust the width guides to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.

Note: Use only paper label sheets. Vinyl, pharmacy, and two‑sided labels are not supported.

For more information on label printing, characteristics, and design, see the Card Stock & Label Guide available at
http://support.lexmark.com.

When printing on labels:

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:

– The labels can withstand temperatures up to 240°C (464°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 172‑kPa (25‑psi) pressure without
delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and toner cartridge
warranties.

• Do not use labels with exposed adhesive.

• Do not print within 1 mm (0.04 inch) of the edge of the label, of the perforations, or between die‑cuts of the label.

• Make sure the adhesive backing does not reach to the edge of the sheet. Zone coating of the adhesive should be
at least 1 mm (0.04 inch) away from edges. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, then remove a 2‑mm (0.08‑inch) strip on the leading and driver edge,
and then use a non‑oozing adhesive.

• Portrait orientation is recommended, especially when printing bar codes.

Tips on using letterhead
• Use letterhead designed specifically for laser printers.

• Print samples on the letterhead being considered for use before buying large quantities.

• Before loading letterhead, flex, fan, and straighten the stack to prevent sheets from sticking together.

• Page orientation is important when printing on letterhead. For information on how to load letterhead, see:

– “Loading trays” on page 29

– “Loading the multipurpose feeder” on page 33

Tips on using transparencies
• Print a test page on the transparencies being considered for use before buying large quantities.

• Feed transparencies from the standard tray, or the multipurpose feeder.
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• Use transparencies designed specifically for laser printers. Transparencies must be able to withstand temperatures
up to 185°C (365°F) without melting, discoloring, offsetting, or releasing hazardous emissions.

Note: If the transparency weight is set to Heavy and the transparency texture is set to Rough in the Paper menu,
then transparencies can be printed at a temperature up to 195°C (383°F).

• Avoid getting fingerprints on the transparencies to prevent print quality problems.

• Before loading transparencies, flex, fan, and straighten the stack to prevent sheets from sticking together.

Paper guidelines
Selecting the correct paper or specialty media reduces printing problems. For the best print quality, try a sample of the
paper or specialty media before buying large quantities.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight

The printer trays can automatically feed paper weights up to 120‑g/m2 (32‑lb) bond grain long paper. The multipurpose
feeder can automatically feed paper weights up to 163‑g/m2 (43‑lb) bond grain long paper. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75‑g/m2 (20‑lb)
bond grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 inches), we recommended to use 90 g/m2

(24 lb) or heavier paper.

Note: Two‑sided printing is supported only for 60–90‑g/m2 (16–24‑lb) bond paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If paper is
too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield
points; however, smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend
the time to several days if the storage or transportation environment is very different from the printer environment.
Thick paper may also require a longer conditioning period.
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Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60–90‑g/m2 (16–24‑lb) bond paper, grain long paper is recommended.

Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Selecting paper
Using the appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid paper jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended printable side of the paper. This information is usually indicated on
the paper package.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 90 g/m2 (16 to 24 lb) weight paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.

Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without melting or
releasing hazardous emissions.

Using recycled paper and other office papers
As an environmentally conscientious company, Lexmark supports the use of recycled paper produced specifically for
use in laser (electrophotographic) printers.

While no blanket statement can be made that all recycled paper will feed well, Lexmark consistently tests papers that
represent recycled cut size copier papers available on the global market. This scientific testing is conducted with rigor
and discipline. Many factors are taken into consideration both separately and as a whole, including the following:

• Amount of post-consumer waste (Lexmark tests up to 100% post-consumer waste content.)

• Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)
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• Moisture content (Business papers should have low moisture: 4–5%.)

• Bending resistance and proper stiffness means optimum feeding through the printer.

• Thickness (impacts how much can be loaded into a tray)

• Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)

• Surface friction (determines how easily sheets can be separated)

• Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it moves
through the printer)

• Brightness and texture (look and feel)

Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree of control
over foreign matter. And while recycled papers are one good path to printing in an environmentally responsible manner,
they are not perfect. The energy required to de-ink and deal with additives such as colorants and “glue” often generates
more carbon emissions than does normal paper production. However, using recycled papers enables better resource
management overall.

Lexmark concerns itself with the responsible use of paper in general based on life cycle assessments of its products. To
gain a better understanding of the impact of printers on the environment, the company commissioned a number of
life cycle assessments and found that paper was identified as the primary contributor (up to 80%) of carbon emissions
caused throughout the entire life of a device (from design to end-of-life). This is due to the energy-intensive
manufacturing processes required to make paper.

Thus, Lexmark seeks to educate customers and partners on minimizing the impact of paper. Using recycled paper is
one way. Eliminating excessive and unnecessary paper consumption is another. Lexmark is well-equipped to help
customers minimize printing and copying waste. In addition, the company encourages purchasing paper from suppliers
who demonstrate their commitment to sustainable forestry practices.

Lexmark does not endorse specific suppliers, although a converter’s product list for special applications is maintained.
However, the following paper choice guidelines will help alleviate the environmental impact of printing:

1 Minimize paper consumption.

2 Be selective about the origin of wood fiber. Buy from suppliers who carry certifications such as the Forestry
Stewardship Council (FSC) or the Program for the Endorsement of Forest Certification (PEFC). These certifications
guarantee that the paper manufacturer uses wood pulp from forestry operators that employ environmentally and
socially responsible forest management and restoration practices.

3 Choose the most appropriate paper for printing needs: normal 75 or 80 g/m2 certified paper, lower weight paper,
or recycled paper.

Unacceptable paper examples

Test results indicate that the following paper types are at risk for use with laser printers:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (± 0.9 in.),
such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with a software
application to successfully print on these forms.)

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough-edged, rough or heavily textured surface papers or curled papers

• Recycled papers that fail EN12281:2002 (European testing)
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• Paper weighing less than 60 g/m2 (16 lb)

• Multiple part forms or documents

For more information about Lexmark, visit www.lexmark.com. General sustainability-related information can be found
at the Environmental Sustainability link.

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent. Most
label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) with relative humidity
between 40 and 60 percent.

• Store paper in cartons, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

• Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and wrapper
help keep the paper clean, dry, and flat.

Supported paper sizes, types, and weights

Supported paper sizes
Note: For an unlisted paper size, select the closest larger listed size. For information on card stock and labels, see the
Card Stock & Label Guide.

Paper size Standard tray Optional 250‑ or
550‑sheet tray

Multipurpose feeder Duplex mode

A4

210 x 297 mm (8.3 x 11.7 in.)

A5

148 x 210 mm (5.8 x 8.3 in.)

X

A6

105 x 148 mm (4.1 x 5.8 in.)

X X

JIS B5

182 x 257 mm (7.2 x 10.1 in.)

X

Letter

216 x 279 mm (8.5 x 11 in.)

1 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
2 Universal is supported only in the standard tray if the paper size is at least 105 x 148 mm (4.1 x 5.8 in.). Universal is supported
only in the optional 250- or 550-sheet tray if the paper size is at least 148 x 210 mm (5.8 x 8.3 in.). Universal is only supported
in duplex mode if the width is at least 210 mm (8.3 in.) and length is at least 279 mm (11 in.). The smallest supported Universal
size is only supported in the multipurpose feeder.
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Paper size Standard tray Optional 250‑ or
550‑sheet tray

Multipurpose feeder Duplex mode

Legal

216 x 356 mm (8.5 x 14 in.)

Executive

184 x 267 mm (7.3 x 10.5 in.)

X

Oficio (Mexico)1

216 x 340 mm (8.5 x 13.4 in.)

Folio

216 x 330 mm (8.5 x 13 in.)

Statement

140 x 216 mm (5.5 x 8.5 in.)

X

Universal2

76.2 x 127 mm (3 x 5 in.) up to
216 x 356 mm (8.5 x 14 in.)

7 3/4 Envelope (Monarch)

98 x 191 mm (3.9 x 7.5 in.)

X X X

9 Envelope

98 x 225 mm (3.9 x 8.9 in.)

X X X

10 Envelope

105 x 241 mm (4.1 x 9.5 in.)

X X X

DL Envelope

110 x 220 mm (4.3 x 8.7 in.)

X X X

C5 Envelope

162 x 229 mm (6.4 x 9 in.)

X X X

B5 Envelope

176 x 250 mm (6.9 x 9.8 in.)

X X X

Other Envelope

229 x 356 mm (9 x 14 in.)

X X X

1 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software application.
2 Universal is supported only in the standard tray if the paper size is at least 105 x 148 mm (4.1 x 5.8 in.). Universal is supported
only in the optional 250- or 550-sheet tray if the paper size is at least 148 x 210 mm (5.8 x 8.3 in.). Universal is only supported
in duplex mode if the width is at least 210 mm (8.3 in.) and length is at least 279 mm (11 in.). The smallest supported Universal
size is only supported in the multipurpose feeder.

Supported paper types and weights

The standard tray supports 60–90‑g/m2 (16–24‑lb) paper weights. The optional tray supports 60–120‑g/m2 (16–32‑lb)
paper weights. The multipurpose feeder supports 60–163‑g/m2 (16–43‑lb) paper weights.
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Paper type 250‑ or 550‑sheet tray Multipurpose feeder Duplex mode

Plain paper

Card stock X X

Transparencies X

Recycled

Glossy paper X X X

Paper labels1 X

Vinyl labels X X X

Bond2

Envelope X X

Rough envelope X X

Letterhead

Preprinted

Colored Paper

Light Paper

Heavy Paper2

Rough/Cotton X

1 One‑sided paper labels designed for laser printers are supported for occasional use. It is recommended to print 20 or fewer
pages of paper labels per month. Vinyl, pharmacy, and two‑sided labels are not supported.
2 Bond and Heavy Paper are supported in duplex mode up to 90‑g/m2 (24‑lb) paper weight.
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Printing

Printing a document

Printing a document
1 From the Paper menu on the printer control panel, set the paper type and size to match the paper loaded.

2 Send the print job:

For Windows users

a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup.

c Adjust the settings, if necessary.

d Click OK > Print.

For Macintosh users

a Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.

b Customize the settings in the Page Setup dialog if necessary:
1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop‑up menus adjust the settings if necessary.

Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.

3 Click Print.

Adjusting toner darkness

Using the Embedded Web Server

1 Open a Web browser, and then type the IP address of the printer in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Quality Menu > Toner Darkness.

3 Adjust the toner darkness, and then click Submit.
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Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Print Settings >  > Quality Menu >  > Toner Darkness

2 Adjust the toner darkness, and then press .

Printing confidential and other held jobs

Printing confidential and other held jobs
Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and Reserve
jobs are held in the printer until you delete them.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Click Print and Hold.

4 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

5 Click OK or Print.

6 From the printer home screen, release the print job.

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

For Macintosh users

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.

3 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

4 Click OK or Print.

5 From the printer home screen, release the print job.

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print
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Printing information pages

Printing a font sample list
1 From the printer control panel, navigate to:

 > Settings >  > Reports >  > Print Fonts

2 Press the up or down arrow button to select the font setting.

3 Press .

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Printing a directory list
From the printer control panel, navigate to:

 > Settings > Reports >  > Print Directory > 

Note: The Print Directory menu item appears only when an optional flash memory or printer hard disk is installed.

Canceling a print job

Canceling a print job from the printer control panel

From the printer control panel, press  > .

Canceling a print job from the computer

For Windows users

1 Open the printers folder.

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type control printers > OK

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Double‑click the printer icon.
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3 Select the print job you want to cancel.

4 Click Delete.

For Macintosh users

1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan > select your printer > Open Print Queue

• System Preferences > Print & Fax > select your printer > Open Print Queue

2 From the printer window, select the print job you want to cancel, and then delete it.
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Understanding the printer menus

Menus list
Paper Menu Reports Network/Ports

Default Source

Paper Size/Type

Configure MP

Substitute Size

Paper Texture

Paper Weight

Paper Loading

Custom Types

Custom Names1

Universal Setup

Menu Settings Page

Device Statistics

Network Setup Page2

Profiles List

Print Fonts

Print Directory

Print Demo

Asset Report

Active NIC

Standard Network3

Reports

Network Card

TCP/IP

IPv6

Wireless

AppleTalk

Standard USB

Parallel4

SMTP Setup

Security Settings Help

Miscellaneous Security Settings4

Confidential Print

Disk Wiping4

Security Audit Log

Set Date and Time

General Settings

Flash Drive Menu4

Print Settings

Print All Guides

Print Quality

Media Guide

Print Defects Guide

Menu Map

Information Guide

Connection Guide

Moving Guide

Supplies Guide

1 This menu appears only in touch‑screen printer models.
2 Depending on the printer setup, this menu item appears as Network Setup Page or Network [x] Setup Page.
3 Depending on the printer setup, this menu item appears as Standard Network or Network [x].
4 This feature is available only in select printer models.
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Paper menu

Default Source menu

Use To

Default Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, set Configure MP to "Cassette" for MP Feeder to
appear as a menu setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one tray
is empty, the print job continues using the linked tray.

Paper Size/Type menu

Use To

Tray [x] Size
A4
A5
A6
JIS‑B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the paper size loaded in each tray.

Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one
tray is empty, the print job continues using the linked tray.

• The A6 paper size is supported only in Tray 1 and the multipurpose
feeder.

Tray [x] Type
Plain Paper
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of paper loaded in each tray.

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type [x] is
the factory default setting for all other trays.

• If available, a user‑defined name will appear instead of Custom Type [x].

• Use this menu to configure automatic tray linking.

Note: Only installed trays and feeders are listed in this menu.
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Use To

MP Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the paper size loaded in the multipurpose feeder.

Notes:

• Letter is the US factory default setting. A4 is the international factory
default setting.

• From the Paper menu, set Configure MP to “Cassette” for MP Feeder
Size to appear as a menu.

• The multipurpose feeder does not automatically detect paper size.
Make sure to set the paper size value.

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of paper loaded in the multipurpose feeder.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure MP to “Cassette” for MP Feeder
Type to appear as a menu.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the paper size being manually loaded.

Note: Letter is the US factory default setting. A4 is the international factory
default setting.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type being manually loaded.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure MP to “Manual” for Manual Paper
Type to appear as a menu.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the envelope size being manually loaded.

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Manual Envelope Type
Envelope
Rough Envelope
Custom Type [x]

Specify the envelope type being manually loaded.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Configure MP menu

Use To

Configure MP
Cassette
Manual
First

Determine when the printer selects paper from the multipurpose feeder.

Notes:

• Cassette is the factory default setting. Cassette configures the
multipurpose feeder as the automatic paper source.

• Manual sets the multipurpose feeder only for manual‑feed print jobs.

• First configures the multipurpose feeder as the primary paper source.

Substitute Size menu

Use To

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitute a specified paper size if the requested paper size is not available.

Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• Off indicates that no size substitutions are allowed.

• Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu

Use To

Plain Texture
Smooth
Normal
Rough

Specify the relative texture of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Texture
Smooth
Normal
Rough

Specify the relative texture of the card stock loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if card stock is supported.

Transparency Texture
Smooth
Normal
Rough

Specify the relative texture of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Texture
Smooth
Normal
Rough

Specify the relative texture of the recycled paper loaded.

Note: Normal is the factory default setting.
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Use To

Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the labels loaded.

Note: Normal is the factory default setting.

Bond Texture
Smooth
Normal
Rough

Specify the relative texture of the bond paper loaded.

Note: Rough is the factory default setting.

Envelope Texture
Smooth
Normal
Rough

Specify the relative texture of the envelopes loaded.

Note: Normal is the factory default setting.

Rough Envelope Texture
Rough

Specify the relative texture of the rough envelopes loaded.

Letterhead Texture
Smooth
Normal
Rough

Specify the relative texture of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Texture
Smooth
Normal
Rough

Specify the relative texture of the preprinted paper loaded.

Note: Normal is the factory default setting.

Colored Texture
Smooth
Normal
Rough

Specify the relative texture of the colored paper loaded.

Note: Normal is the factory default setting.

Light Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Note: Normal is the factory default setting.

Heavy Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Note: Normal is the factory default setting.

Rough/Cotton Texture
Rough

Specify the relative texture of the cotton paper loaded.

Custom [x] Texture
Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if the custom type is supported.
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Paper Weight menu

Use To

Plain Weight
Light
Normal
Heavy

Specify the relative weight of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Weight
Light
Normal
Heavy

Specify the relative weight of the card stock loaded.

Note: Normal is the factory default setting.

Transparency Weight
Light
Normal
Heavy

Specify the relative weight of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Weight
Light
Normal
Heavy

Specify the relative weight of the recycled paper loaded.

Note: Normal is the factory default setting.

Labels Weight
Light
Normal
Heavy

Specify the relative weight of the labels loaded.

Note: Normal is the factory default setting.

Bond Weight
Light
Normal
Heavy

Specify the relative weight of the bond paper loaded.

Note: Normal is the factory default setting.

Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the envelope loaded.

Note: Normal is the factory default setting.

Rough Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the rough envelope loaded.

Note: Normal is the factory default setting.

Letterhead Weight
Light
Normal
Heavy

Specify the relative weight of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Weight
Light
Normal
Heavy

Specify the relative weight of the preprinted paper loaded.

Note: Normal is the factory default setting.
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Use To

Colored Weight
Light
Normal
Heavy

Specify the relative weight of the colored paper loaded.

Note: Normal is the factory default setting.

Light Weight
Light

Specify that the weight of the paper loaded is light.

Heavy Weight
Heavy

Specify that the weight of the paper loaded is heavy.

Cotton/Rough Weight
Light
Normal
Heavy

Specify the relative weight of the cotton or rough paper loaded.

Note: Heavy is the factory default setting.

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only when the custom type is supported.

Paper Loading menu

Use To

Recycled Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Recycled as the paper type.

Bond Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Bond as the paper type.

Letterhead Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Letterhead as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Preprinted as the paper type.

Colored Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Colored as the paper type.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.

• Off is the factory default setting for all the menus.
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Use To

Light Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Light as the paper type.

Heavy Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Heavy as the paper type.

Custom [x] Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Custom [x] as the paper type.

Note: Custom [x] Loading is available only if the custom type is
supported.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.

• Off is the factory default setting for all the menus.

Custom Types menu

Use To

Custom Type [x]
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope

Associate a paper or specialty media type with a factory default Custom Type [x]
name or a user‑defined custom name created in the Embedded Web Server or
MarkVisionTM Professional. The user‑defined name appears instead of Custom
Type [x].

Notes:

• Paper is the factory default setting for Custom Type [x].

• The custom media type must be supported in the selected tray or feeder
in order to print from that source.

Recycled
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope
Cotton

Specify a paper type when the Recycled setting is selected in other menus.

Notes:

• Paper is the factory default setting.

• The Recycled paper type must be supported in the selected tray or
feeder in order to print from that source.

Custom Names menu

Use To

Custom Name [x] Specify a custom name for a paper type. This name replaces the Custom Type [x]
name in the printer menus.

Note: This menu item appears only in touch‑screen printer models.
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Universal Setup menu

Use To

Units of Measure
Inches
Millimeters

Identify the units of measure.

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.

Portrait Width
3–8.5 inches
76–216 mm

Set the portrait width.

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. You can increase the
width in 0.01‑inch increments.

• 216 mm is the international factory default setting. You can increase
the width in 1‑mm increments.

Portrait Height
3–14.17 inches
76–360 mm

Set the portrait height.

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. You can increase the
height in 0.01‑inch increments.

• 356 mm is the international factory default setting. You can increase
the height in 1‑mm increments.

Feed Direction
Short Edge
Long Edge

Specify the feed direction if the paper can be loaded in either direction.

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only when the longest edge is shorter than the
maximum width supported in the tray.

Reports menu

Reports menu

Use To

Menu Settings Page Print a report containing information about the paper loaded in trays, installed
memory, total page count, alarms, timeouts, printer control panel language,
TCP/IP address, status of supplies, status of the network connection, and other
information.

Device Statistics Print a report containing printer statistics such as supply information and details
about printed pages.
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Use To

Network Setup Page Print a report containing information about the network printer settings, such as
the TCP/IP address information.

Note: This menu item appears only in network printers or in printers connected
to print servers.

Profiles List Print a list of profiles stored in the printer.

Note: This menu item appears only when LDSS is enabled.

Print Fonts
PCL Fonts
PostScript Fonts

Print a report of all the fonts available for the printer language currently set in
the printer.

Note: A separate list is available for PCL and PostScript emulations.

Print Directory Print a list of all the resources stored in an optional flash memory card or printer
hard disk.

Notes:

• Job Buffer Size must be set to 100%.

• Make sure the optional flash memory or printer hard disk is installed
correctly and working properly.

• This menu item appears only when a flash or disk option is installed.

Asset Report Print a report containing printer asset information, such as serial number and
model name.

Network/Ports menu

Active NIC menu

Use To

Active NIC
Auto
[list of available network cards]

Notes:

• Auto is the factory default setting.

• This menu item appears only when an optional network card is installed.

Standard Network or Network [x] menus
Note: Only active ports appear in this menu. All inactive ports are omitted.

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When Off is used, the printer does not examine incoming data. The printer
uses PostScript emulation if PS SmartSwitch is set to On. It uses the default
printer language specified in the Setup menu if PS SmartSwitch is set to Off.
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Use To

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job requires it,
regardless of the default printer language.

Notes:

• On is the factory default setting.

• When Off is used, the printer does not examine incoming data. The printer
uses PCL emulation if PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Network Buffer
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.

Notes:

• Auto is the factory default setting.

• The value can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs in the printer hard disk before printing. This menu only
appears when a formatted disk is installed.

Notes:

• Off is the factory default setting.

• On buffers print jobs on the printer hard disk.

• Auto buffers print jobs only when the printer is busy processing data from
another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.
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Use To

Standard Network Setup OR
Network [x] Setup

Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Display and set the printer network settings.

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Reports menu
To access the menu, navigate to any of the following:

• Network/Ports menu > Networks/Ports > Standard Network > Standard Network Setup > Reports

• Network/Ports menu > Networks/Ports > Network [x] > Network [x] Setup > Reports

Use To

Print Setup Page Print a report containing information about the network printer settings, such as the TCP/IP address.

Network Card menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Network Card

• Network/Ports > Network [x] > Network [x] Setup > Network Card

Use To

View Card Status
Connected
Disconnected

View the connection status of the network card.

View Card Speed View the speed of an active network card.

Network Address
UAA
LAA

View the network addresses.

Job Timeout

0–255 seconds

Set the amount of time it takes for a network print job to be canceled.

Notes:

• 90 seconds is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value of 1–9 is selected, then the setting is saved as 10.
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TCP/IP menu
To access the menu, navigate to any of the following:

• Network/Ports > Standard Network > Standard Network Setup > TCP/IP

• Network/Ports > Network [x] > Network [x] Setup > TCP/IP

Note: This menu is available only in network printers or printers connected to print servers.

Use To

Set Hostname Set the host name.

Notes:

• This setting can be changed only from the Embedded Web Server.

• The host name is limited to 15 characters, and accepts US‑ASCII, alphanumeric
characters and hyphen only.

IP Address View or change the current TCP/IP address.

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask View or change the current TCP/IP netmask.

Gateway View or change the current TCP/IP gateway.

Enable DHCP
On
Off

Specify the DHCP address and parameter assignment.

Note: On is the factory default setting.

Enable RARP
On
Off

Specify the RARP address assignment setting.

Notes:

• On is the factory default setting.

• This menu item appears only in touch‑screen printer models.

Enable BOOTP
On
Off

Specify the BOOTP address assignment setting.

Notes:

• On is the factory default setting.

• This menu item appears only in touch‑screen printer models.

Enable AutoIP
Yes
No

Specify the Zero Configuration Networking setting.

Note: Yes is the factory default setting.

Enable FTP/TFTP
Yes
No

Enable the built-in FTP server, which lets you send files to the printer using File Transfer
Protocol.

Note: Yes is the factory default setting.

Enable HTTP Server
Yes
No

Enable the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

Note: Yes is the factory default setting.

WINS Server Address View or change the current WINS server address.
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Enable DDNS
Yes
No

View or change the current DDNS setting.

Note: Yes is the factory default setting.

Enable mDNS
Yes
No

View or change the current mDNS setting.

Note: Yes is the factory default setting.

DNS Server Address View or change the current DNS server address.

Backup DNS Server Address View or change the backup DNS server addresses.

Backup DNS Server Address 2

Backup DNS Server Address 3

Enable HTTPS
Yes
No

View or change the current HTTPS setting.

Note: Yes is the factory default setting.

IPv6 menu
To access the menu, navigate to any of the following:

• Network/Ports > Standard Network > Standard Network Setup > IPv6

• Network/Ports > Network [x] > Network [x] Setup > IPv6

Note: This menu is available only in network printers or printers connected to print servers.

Use To

Enable IPv6
On
Off

Enable Internet Protocol Version Six (IPv6) in the printer.

IPv6 uses bigger numbers to create IP addresses.

Note: On is the factory default setting.

Auto Configuration
On
Off

Specify whether or not the network adapter accepts the automatic IPv6
address configuration entries provided by a router.

Note: On is the factory default setting.

Set Hostname* Set the host name.

Note: The host name is limited to 15 characters, and accepts US‑ASCII,
alphanumeric characters and hyphen only.

View Address* View the current IPv6 addresses.

View Router Address* View the current router address.

Enable DHCPv6
On
Off

Enable DHCPv6 in the printer.

Note: On is the factory default setting.

* These settings can be changed only from the Embedded Web Server.
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Wireless menu
Note: This menu is available only in printer models connected to a wireless network.

To access the menu, navigate to any of the following:

• Network/Ports > Standard Network > Standard Network Setup >Wireless

• Network/Ports > Network [x] > Network [x] Setup > Wireless

Use To

Wi‑Fi Protected Setup (WPS)
Start Push Button Method
Start PIN Method

Establish a wireless network and enable network security.

Notes:

• Start Push Button Method connects the printer to a wireless
network by pressing buttons on both the printer and the access
point (wireless router) within a given period of time.

• Start PIN Method connects the printer to a wireless network by
using a PIN on the printer and entering it into the wireless settings
of the access point.

Enable/Disable WPS Auto‑detection
Enable
Disable

Automatically detect the connection method that an access point with
WPS uses—Start Push Button Method or Start PIN Method.

Note: Disable is the factory default setting.

Network Mode
Infrastructure
Ad hoc

Specify the network mode.

Notes:

• Ad hoc is the factory default setting. This configures wireless
connection directly between the printer and a computer.

• Infrastructure lets the printer access a network using an access
point.

Compatibility
802.11b/g
802.11b/g/n

Specify the wireless standard for the wireless network.

Note: The 802.11b/g/n is the factory default setting.

Choose Network Select an available network for the printer to use.

View Signal Quality View the quality of the wireless connection.

View Security Mode View the encryption method for the wireless network.

AppleTalk menu
Note: This menu is available only in printer models connected to a wired network or when an optional network card
is installed.

To access the menu, navigate to any of the following:

• Network/Ports > Standard Network > Standard Network Setup > AppleTalk

• Network/Ports > Network Setup [x] > AppleTalk
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Activate
Yes
No

Enable or disable AppleTalk support.

Note: Yes is the factory default setting.

View Name Show the assigned AppleTalk name.

Note: The name can be changed only from the Embedded Web Server.

View Address Show the assigned AppleTalk address.

Note: The address can be changed only from the Embedded Web Server.

Set Zone
[list of zones available on the network]

Provide a list of AppleTalk zones available on the network.

Note: The factory default setting is the default zone for the network. If no
default zone exists, then the zone marked with an asterisk (*) is the default
setting.

Standard USB menu

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if the PS SmartSwitch is set to On. It uses the default
printer language specified in the Setup menu if the PS SmartSwitch is set to
Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if the PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if the PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then process it appropriately.

• The printer automatically restarts when changing the setting from the printer
control panel. The menu selection is then updated.
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USB Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the USB input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any jobs already buffered on the printer hard
disk are printed before normal processing resumes.

• The USB buffer size value can be changed in 1-K increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel, serial, and network buffers.

• The printer automatically restarts when the setting is changed from the printer
control panel. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs in the printer hard disk before printing.

Notes:

• Off is the factory default setting.

• On buffers jobs on the printer hard disk.

• Auto buffers print jobs only if the printer is busy processing data from another
input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• On processes raw binary PostScript print jobs.

• Off filters print jobs using the standard protocol.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

Parallel [x] menu
Note: This menu appears only when an optional parallel card is installed.
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PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if PS SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Parallel Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the parallel input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any print jobs already buffered on the printer
hard disk are printed before normal processing resumes.

• The parallel buffer size setting can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Parallel Buffer, disable or reduce
the size of the USB, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Job Buffering
Off
On
Auto

Temporarily store print jobs on the printer hard disk before printing.

Notes:

• Off is the factory default setting.

• On buffers print jobs on the printer hard disk.

• Auto buffers print jobs only if the printer is busy processing data from another
input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.
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Advanced Status
On
Off

Enable bidirectional communication through the parallel port.

Notes:

• On is the factory default setting.

• Off disables parallel port negotiation.

Protocol
Standard
Fastbytes

Specify the parallel port protocol.

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• Standard tries to resolve parallel port communication problems.

Honor Init
On
Off

Determine if the printer honors printer hardware initialization requests from the
computer.

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the Init signal from the
parallel port. Many personal computers activate the Init signal each time the
computer is turned on.

Parallel Mode 2
On
Off

Determine if the parallel port data is sampled on the leading or trailing edge of a
strobe.

Note: On is the factory default setting.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.
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SMTP Setup menu

Use To

Primary SMTP Gateway Specify SMTP server gateway and port information.

Note: 25 is the default SMTP gateway port.Primary SMTP Gateway Port

Secondary SMTP Gateway

Secondary SMTP Gateway Port

SMTP Timeout
5–30

Specify the amount of time in seconds before the server stops trying to
send an e‑mail.

Note: 30 seconds is the factory default setting.

Reply Address Specify a reply address of up to 128 characters in the e-mail sent by the
printer.

Use SSL
Disabled
Negotiate
Required

Set the printer to use SSL for increased security when connecting to the
SMTP server.

Notes:

• Disabled is the factory default setting.

• When the Negotiate setting is used, the SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specify the type of user authentication required for printing privileges.

Note: “No authentication required” is the factory default setting.

Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specify what credentials will be used when communicating to the SMTP
server. Some SMTP servers require credentials to send an e-mail.

Notes:

• None is the factory default setting for Device‑Initiated E‑mail.

• Device Userid and Device Password are used to log in to the SMTP
server when Use Device SMTP Credentials is selected.

Device Userid

Device Password
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Security menu

Miscellaneous Security Settings menu

Use To

Login Restrictions
Login failures*
Failure time frame*
Lockout time*
Panel Login Timeout
Remote Login Timeout

Limit the number and time frames of failed login attempts from the printer control
panel before all users are locked out.

Notes:

• “Login failures” specifies the number of failed login attempts before users are
locked out. Settings range from 1–10. 3 attempts is the factory default setting.

• “Failure time frame” specifies the time frame during which failed login
attempts can be made before users are locked out. Settings range from 1–60
minutes. 5 minutes is the factory default setting.

• “Lockout time” specifies how long users are locked out after exceeding the
login failures limit. Settings range from 1–60 minutes. 5 minutes is the factory
default setting.

• Panel Login Timeout specifies how long the printer remains idle on the home
screen before automatically logging the user off. Settings range from 1–900
seconds. 3 seconds is the factory default setting.

• Remote Login Timeout specifies how long a remote interface remains idle
before automatically logging the user off. Settings range from 1–120 minutes.
10 minutes is the factory default setting.

Minimum PIN Length
1–16

Limit the digit length of the PIN.

Note: 4 is the factory default setting.

* These menus appear only in touch-screen printer models.

Confidential Print menu

Use To

Max Invalid PIN
Off
2–10

Limit the number of times an invalid PIN can be entered.

Notes:

• This menu appears only when a formatted, non-defective printer hard disk is installed.

• Once the limit is reached, the print jobs for that user name and PIN are deleted.

Confidential Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Limit the amount of time a confidential print job stays in the printer before it is deleted.

Notes:

• If the “Confidential Job Expiration” setting is changed while confidential print jobs
reside in the printer RAM or printer hard disk, then the expiration time for those print
jobs does not change to the new default value.

• If the printer is turned off, then all confidential jobs held in the printer RAM are
deleted.

Note: Off is the factory default setting.
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Repeat Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs.

Verify Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs needing verification.

Reserve Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs for printing at a later time.

Note: Off is the factory default setting.

Security Audit Log menu

Use To

Export Log Let an authorized user export the audit log.

Notes:

• To export the audit log from the printer control panel, connect a flash drive to
the printer.

• You can also download the audit log from the Embedded Web Server, and
then save it on your computer.

Delete Log
Delete now
Do not delete

Specify whether or not audit logs are deleted.

Note: Delete now is the factory default setting.
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Configure Log
Enable Audit

Yes
No

Enable Remote Syslog
No
Yes

Remote Syslog Facility
0–23

Severity of events to log
0–7

Specify how and whether or not audit logs are created.

Notes:

• Enable Audit determines if events are recorded in the secure audit log and
remote syslog. No is the factory default setting.

• Enable Remote Syslog determines if logs are sent to a remote server. No is the
factory default setting.

• Remote Syslog Facility determines the value used to send logs to the remote
syslog server. 4 is the factory default setting.

• If the security audit log is activated, then the severity value of each event is
recorded. 4 is the factory default setting.

Disk Wiping menu
Disk Wiping erases only print job data on the printer hard disk that are not currently in use by the file system. All
permanent data on the printer hard disk are preserved, such as downloaded fonts, macros, and held jobs.

Note: This menu appears only when a formatted, non-defective printer hard disk is installed.

Use To

Wiping Mode
Auto

Specify the mode for disk wiping.

Automatic Method
Single pass
Multiple pass

Mark all disk space used by a previous print job. This method does not permit the file
system to reuse this space until it has been cleared.

Notes:

• “Single pass” is the factory default setting.

• Only automatic wiping enables users to activate disk wiping without having to
turn the printer off for an extended amount of time.

• Highly confidential information should be wiped using only the Multiple pass
method.

Set Date and Time menu

Use To

Current Date and Time Show the current date and time settings for the printer.

Manually Set Date and Time
[input date/time]

Enter the date and time.

Notes:

• For touch‑screen printer models, date and time are set in YYYY-MM-DD
HH:MM format.

• Manually setting the date and time sets Enable NTP to No.

• For non‑touch‑screen printer models, the wizard lets you set the date and
time in YYYY‑MM‑DD‑HH:MM format.
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Time Zone
[list of time zones]

Select the time zone.

Note: GMT is the factory default setting for non‑touch‑screen printer models.

Automatically observe DST
On
Off

Set the printer to use the applicable daylight saving time (DST) start and end times
associated with the printer Time Zone setting.

Note: On is the factory default setting.

Enable NTP
On
Off

Enable Network Time Protocol, which synchronizes the clocks of devices on a
network.

Notes:

• On is the factory default setting.

• The setting is turned off if you manually set the date and time.
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Settings menu

General Settings

General Settings menu

Use To

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Set the language of the text appearing on the printer display.

Note: Not all languages are available for all printers, and you may
need to install special hardware for those languages to appear.

Show Supply Estimates
Show estimates
Do not show estimates

Display the estimates of the supplies on the printer control panel,
Embedded Web Server, menu settings, and the device statistics
reports.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimize the use of energy, paper, or specialty media.

Notes:

• For touch‑screen printer models, touch Eco‑Mode, and then
select from the options.

• Off is the factory default setting. Off resets the printer to its
factory default settings.

• Energy minimizes the power used by the printer.

• Energy/Paper minimizes the use of power and of paper and
specialty media.

• Paper minimizes the amount of paper and specialty media
needed for a print job.

Quiet Mode
Off
On

Reduce the amount of noise produced by the printer.

Notes:

• For touch‑screen printer models, touch Quiet Mode, and
then select from the options.

• Off is the factory default setting. This setting supports the
performance specifications for your printer.

• On configures the printer to produce as little noise as
possible. This setting is best suited for printing text and line
art.

• For optimal printing of color‑rich documents, set Quiet Mode
to Off.

• Selecting Photo from the printer driver may disable Quiet
Mode and provide better print quality and full speed
printing.

Run Initial setup
Yes
No

Instruct the printer to run the setup wizard.

Notes:

• Yes is the factory default setting.

• After completing the setup wizard by selecting Done at the
Country select screen, the default becomes No.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Keyboard1

Keyboard Type
English
Francais
Francais Canadien
Deutsch
Italiano
Espanol
Greek
Dansk
Norsk
Nederlands
Svenska
Suomi
Portuguese
Russian
Polski
Swiss German
Swiss French
Korean
Magyar
Turkish
Czech
Simplified Chinese
Traditional Chinese
Japanese

Custom Key [x]

Specify a language and custom key information for the printer
control panel keyboard. The additional tabs enable access to accent
marks and symbols from the printer control panel keyboard.

Paper Sizes
US
Metric

Specify the unit of measurement for paper sizes.

Notes:

• US is the factory default setting.

• The initial setting is determined by your country or region
selection in the initial setup wizard.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Displayed Information1

Left side
Right side
Custom Text [x]

Specify what is displayed on the upper left and right corners of the
home screen.

For the Left side and Right side options, select from the following
options:

None
IP Address
Hostname
Contact Name
Location
Date/Time
mDNS/DDNS Service Name
Zero Configuration Name
Custom Text [x]
Model Name

Notes:

• IP Address is the factory default setting for Left side.

• Date/Time is the factory default setting for Right side.

Displayed Information (continued)1

Black Toner

Customize the displayed information for Black Toner.

Select from the following options:
When to display

Do not display
Display

Message to Display
Default
Alternate

Default
[text entry]

Alternate
[text entry]

Notes:

• “Do not display” is the factory default setting for When to
display.

• “Default” is the factory default setting for Message to
Display.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.

Understanding the printer menus 80



Use To

Displayed Information (continued)1

Paper Jam
Load Paper
Service Errors

Customize the displayed information for Waste Toner Bottle, Paper
Jam, Load Paper, and Service Errors.

Select from the following options:
Display

Yes
No

Message to Display
Default
Alternate

Default
[text entry]

Alternate
[text entry]

Notes:

• No is the factory default setting for Display.

• Default is the factory default setting for Message to Display.

Home screen customization
Change Language
Search Held Jobs
Held Jobs
USB Drive
Profiles and Solutions
Bookmarks
Jobs by user
Forms and Favorites
Eco-Settings
Showroom
Change Background

Change the icons and buttons that appear on the home screen.

For each icon or button, select from the following options:
Display
Do not display

Notes:

• “Display” is the factory default setting for Search Held Jobs,
Held Jobs, USB Drive, Forms and Favorites, Eco‑Settings,
Showroom, and Change Background.

• “Do not display” is the factory default setting for Change
Language, Profiles and Solutions, Bookmarks, and Jobs by
user.

• “Bookmarks” appears inside Held Jobs only if Show
Bookmarks is set to Yes and an active network cable is
attached.

Date Format1

MM‑DD‑YYYY
DD‑MM‑YYYY
YYYY‑MM‑DD

Format the printer date.

Note: MM-DD-YYYY is the US factory default setting.

Time Format1

12 hour A.M./P.M.
24 hour clock

Format the printer time.

Screen Brightness1

20–100

Specify the brightness of the printer display.

Note: 100 is the factory default setting.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Audio Feedback1

Button Feedback
On
Off

Volume
1–10

Specify whether icons and buttons have audio feedback.

Notes:

• On is the factory default setting for Button Feedback.

• 5 is the factory default setting for Volume.

Show Bookmarks1

Yes
No

Specify whether bookmarks are displayed from the Held Jobs area.

Note: Yes is the factory default setting. When Yes is selected,
bookmarks appear in the Held Jobs area.

Web Page Refresh Rate1

30–300

Specify the number of seconds between Embedded Web Server
refreshes.

Note: 120 is the factory default setting.

Contact Name1 Specify a contact name for the printer.

Note: The contact name will be stored on the Embedded Web
Server.

Location1 Specify the location of the printer.

Note: The location will be stored on the Embedded Web Server.

Timeouts

Standby Mode1

Disabled
1–240

Specify the number of minutes of inactivity before the printer
enters a lower power state.

Note: 15 is the factory default setting.

Timeouts
Sleep Mode

Disabled
1–120 min

Set the amount of time the printer waits after a job is printed before
it goes into a reduced power state.

Notes:

• “30 min” is the factory default setting.

• “Disabled” appears only when Energy Conserve is set to Off.

• Lower settings conserve more energy, but may require
longer warm‑up times.

• Select a high setting if the printer is in constant use. Under
most circumstances, this keeps the printer ready to print
with minimum warm‑up time.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Timeouts
Hibernate Timeout

Disabled
1 hour
2 hours
3 hours
6 hours
1 day
2 days
3 days
1 week
2 weeks
1 month

Set the amount of time the printer waits before it enters Hibernate
mode.

Notes:

• “Disabled” is the factory default setting in all countries
except European Union countries and Switzerland.

• “3 days” is the factory default setting for all European Union
countries and Switzerland.

Timeouts
Hibernate Timeout on Connection

Hibernate
Do Not Hibernate

Set the printer to Hibernate mode even if there is an active Ethernet
connection.

Note: “Do Not Hibernate” is the factory default setting.

Timeouts
Screen Timeout

15–300 sec

Set the amount of time in seconds the printer waits before
returning the display to the ready state.

Note: “30 sec” is the factory default setting.

Timeouts
Prolong Screen Timeout

On
Off

Display a message that lets you reset the screen timeout timer
instead of returning to the home screen.

Note: Off is the factory default setting.

Timeouts
Print Timeout

Disabled
1–255 sec

Set the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print
job.

Notes:

• “90 sec” is the factory default setting.

• When the timer expires, any partially printed page still in the
printer is printed.

• Print Timeout is available only when using PCL emulation.
This setting has no effect on PostScript emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535 sec

Set the amount of time in seconds the printer waits for additional
data before canceling a print job.

Notes:

• “40 sec” is the factory default setting.

• This setting has no effect on PCL emulation print jobs.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Print Recovery
Auto Continue

Disabled
5–255 sec

Let the printer automatically continue printing from certain offline
situations when these are not resolved within the specified time
period.

Note: Disabled is the factory default setting.

Print Recovery
Jam Recovery

On
Off
Auto

Specify whether the printer reprints jammed pages.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.

Print Recovery
Jam Assist

On
Off

Notes:

• On is the factory default setting. On sets the printer to
automatically dump or partially printed pages to the
standard bin after a jammed page has been cleared.

• Off requires the user to remove all pages from all possible
jam locations.

Print Recovery
Page Protect

Off
On

Let the printer successfully print a page that may not have printed
otherwise.

Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.

Hibernate Timeout on Connection
Hibernate
Do Not Hibernate

Set the printer to hibernate mode even there is an active Ethernet
connection.

Note: Do Not Hibernate is the factory default setting.

Press Sleep Button
Do nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a short
press of the Sleep button.

Note: Sleep is the factory default setting.

Press and Hold Sleep Button
Do nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a long press
of the Sleep button.

Note: “Do nothing” is the factory default setting.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.
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Use To

GUI Log Level1

Everything (0)
Keys (1)
Debug (2)
Warnings (3)
Errors (4)
Critical (5)
System Info (6)

Note: This setting only appears in debug builds.

Factory Defaults
Do Not Restore
Restore Now

Return the printer settings to the factory default settings.

Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user‑defined settings.

• All downloads stored in the RAM are deleted. Downloads
stored in the flash memory or in the printer hard disk are not
affected.

Custom Home Message2

Off
IP Address
Hostname
Contact Name
Location
Zero Configuration Name
Custom Text [x]

Select a custom home message that appears as an alternating
display of the printer status.

Note: Off is the factory default setting.

Export Configuration Package1

Export

Export files from the flash drive.

1 This menu item appears only in touch‑screen printer models.
2 This menu item appears only in non‑touch‑screen printer models.

Flash Drive

Flash Drive menu

Note: This menu appears only in touch‑screen printer models.

Use To

Copies
1–999

Specify a default number of copies for each print job.

Note: 1 is the factory default setting.

Paper Source
Tray [x]
MP Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Note: Tray 1 (standard tray) is the factory default setting.
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Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stack the pages of a print job in sequence when printing multiple copies.

Note: On is the factory default setting.

Sides (Duplex)
1 sided
2 sided

Specify whether prints are on one side or on both sides of the paper.

Note: 1 sided is the factory default setting.

Duplex Binding
Long Edge
Short Edge

Define binding for duplexed pages in relation to paper orientation.

Notes:

• Long Edge is the factory default setting. Long Edge assumes binding along the
long edge of the page (left edge for portrait and top edge for landscape).

• Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).

Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specify that multiple‑page images be printed on one side of a paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple‑page images.

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they are in
portrait or landscape orientation.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple‑page document.

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Paper Saver Border
None
Solid

Print a border on each page image.

Note: None is the factory default setting.
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Use To

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether blank separator sheets are inserted.

Notes:

• Off is the factory default setting. No separator sheets are included in the print
job.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to On. If Collate is set to Off, then a blank page is inserted
between each set of printed pages, such as after all page 1's and after all page
2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.

Separator Sheet Source
Tray [x]
Manual Feeder

Specify the paper source for separator sheets.

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, Configure MP must be set to Cassette in order for
Manual Feeder to appear as a menu setting.

Blank Pages
Do Not Print
Print

Specify whether blank pages are inserted in a print job.

Note: Do Not Print is the factory default setting.

Print Settings

Setup menu

Use To

Printer Language
PCL Emulation
PS Emulation

Set the default printer language.

Notes:

• PCL Emulation is the factory default setting.

• PostScript emulation uses a PostScript interpreter for
processing print jobs.

• PCL Emulation uses a PCL interpreter for processing print
jobs.

• Setting a printer language default does not prevent a
software program from sending print jobs that use another
printer language.
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Use To

Print Area
Normal
Whole Page

Set the logical and physical printable area.

Notes:

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

• Whole Page allows the image to be moved into the
non‑printable area defined by the Normal setting. This
setting affects only pages printed using a PCL 5e interpreter
and has no effect on pages printed using the PCL XL or
PostScript interpreter.

Download Target
RAM
Flash

Set the storage location for downloads.

Notes:

• RAM is the factory default setting. Storing downloads in the
RAM is temporary.

• Storing downloads in a flash memory or on a printer hard
disk places them in permanent storage. Downloads remain in
the flash memory or printer hard disk even when the printer
is turned off.

• This menu item appears only when a flash or disk option is
installed.

Resource Save
On
Off

Specify how the printer handles temporary downloads, such as
fonts and macros stored in the RAM, when the printer receives a
print job that requires more memory than is available.

Notes:

• Off is the factory default setting. Off sets the printer to retain
downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• On sets the printer to retain downloads during language
changes and printer resets. If the printer runs out of
memory, then Memory Full 38 appears on the printer
display, but downloads are not deleted.

Print All Order
Alphabetical
Oldest First
Newest First

Specify the order in which held and confidential jobs are printed
when Print All Order is selected.

Note: Alphabetical is the factory default setting.
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Finishing menu

Use To

Sides (Duplex)
1 sided
2 sided

Specify whether two‑sided (duplex) printing is set as the default for all print jobs.

Notes:

• “1 sided” is the factory default setting.

• You can set two‑sided printing from the software program.

For Windows users:

1 Click File > Print.

2 Click Properties, Preferences, Options, or Setup.

For Macintosh users:

1 Choose File > Print.

2 Adjust the settings from the print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Define the way two‑sided pages are bound and printed.

Notes:

• Long Edge is the factory default setting. Long Edge binds pages along their long
edge (left edge for portrait and top edge for landscape).

• Short Edge binds pages along their short edge (top edge for portrait and left
edge for landscape).

Copies
1–999

Specify the default number of copies for each print job.

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify whether to insert blank pages in a print job.

Note: Do Not Print is the factory default setting.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Note: “(1,2,3) (1,2,3)” is the factory default setting.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether to insert blank separator sheets.

Notes:

• Off is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to (1,1,1) (2,2,2). If Collate is set to (1,2,3) (1,2,3), then a blank
page is inserted between each set of printed pages, such as after all page 2's
and after all page 3's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of a print job. This
setting is useful when printing transparencies or when inserting blank pages in
a document.

Separator Source
Tray [x]
Multi‑Purpose Feeder

Specify the paper source for separator sheets.

Note: Tray 1 (standard tray) is the factory default setting.
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Use To

Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Print multiple‑page images on one side of a paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per side.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple‑page images when using Paper Saver.

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they are in
portrait or landscape orientation.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple‑page document.

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Paper Saver Border
None
Solid

Print a border when using Paper Saver.

Note: None is the factory default setting.

Quality menu

Use To

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specify the printed output resolution in dots per inch.

Note: 600 dpi is the factory default setting.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions
Isolated

Enable more pixels to print in clusters for clarity, in order to enhance images horizontally
or vertically, or to enhance fonts.

Note: Off is the factory default setting.

Toner Darkness
1–10

Lighten or darken the printed output.

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.
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Use To

Enhance Fine Lines
On
Off

Enable a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts.

Notes:

• Off is the factory default setting.

• You can set this option from the printer software. For Windows users, click File >
Print, and then click Properties, Preferences, Options, or Setup. For Macintosh
users, choose File > Print, and then adjust the settings from the Print dialog and
pop‑up menus.

• To set this option using the Embedded Web Server, type the network printer IP
address in the Web browser address field.

Gray Correction
Auto
Off

Automatically adjust the contrast enhancement applied to images.

Note: Auto is the factory default setting.

Brightness
‑6 to 6

Adjust the printed output either by lightening or darkening it. You can conserve toner
by lightening the output.

Note: 0 is the factory default setting.

Contrast
0–5

Adjust the contrast of printed objects.

Note: 0 is the factory default setting.

Job Accounting menu

Note: This menu item appears only when a formatted, non-defective printer hard disk is installed. Make sure the
printer hard disk is not read/write‑ or write‑protected.

Use To

Job Accounting Log
Off
On

Determine and set if the printer creates a log of the print jobs it receives.

Note: Off is the factory default setting.

Job Accounting Utilities Print and delete log files or export them to a flash drive.

Accounting Log Frequency
Weekly
Monthly

Determine and set how often a log file is created.

Note: Monthly is the factory default setting.

Log Action at End of Frequency
None
E‑mail Current Log
E‑mail & Delete Current Log
Post Current Log
Post & Delete Current Log

Determine and set how the printer responds when the frequency threshold expires.

Note: None is the factory default setting.

Disk Near Full Level
Off
1–99

Specify the maximum size of the log file before the printer executes the Disk Near
Full Action.

Note: 5 is the factory default setting.
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Use To

Disk Near Full Action
None
E‑mail Current Log
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post Current Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when the printer hard disk is nearly full.

Notes:

• None is the factory default setting.

• The value defined in Disk Near Full Level determines when this action is
triggered.

Disk Full Action
None
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when disk usage reaches the maximum
limit (100MB).

Note: None is the factory default setting.

URL to Post Logs Determine and set where the printer posts job accounting logs.

E‑mail Address to Send Logs Specify the e‑mail address to which the device sends job accounting logs.

Log File Prefix Specify the prefix you want for the log file name.

Note: The current host name defined in the TCP/IP menu is used as the default log
file prefix.

Utilities menu

Use To

Remove Held Jobs
Confidential
Held
Not Restored
All

Delete confidential and held jobs from the printer hard disk.

Notes:

• Selecting a setting affects only print jobs that are resident in the printer.
Bookmarks, print jobs on flash drives, and other types of held jobs are not
affected.

• Not Restored removes all Print and Hold jobs that are not restored from the
printer hard disk or memory.
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Use To

Format Flash
Yes
No

Format the flash memory.

Warning—Potential Damage: Do not turn off the printer while the flash memory is
being formatted.

Notes:

• Yes deletes all data stored in flash memory.

• No cancels the format request.

• Flash memory refers to the memory added by installing a flash memory card in
the printer.

• The flash memory option card must not be read/write‑ or write‑protected.

• This menu item appears only when a non‑defective flash memory card is
installed.

Delete Downloads on Disk
Delete Now
Do Not Delete

Delete downloads from the printer hard disk, including all held jobs, buffered jobs,
and parked jobs.

Notes:

• Delete Now sets the printer to delete the downloads and allows the display to
return to the originating screen after the deletion.

• Do Not Delete sets the printer display to return to the main Utilities menu for
touch‑screen printer models. When selected in non‑touch‑screen printer
models, Do Not Delete sets the printer to return to the originating screen after
the deletion.

Activate Hex Trace Assist in isolating the source of a print job problem.

Notes:

• When activated, all data sent to the printer is printed in hexadecimal and
character representation, and control codes are not executed.

• To exit or deactivate Hex Trace, turn off or reset the printer.

Coverage Estimator
Off
On

Provide an estimate of the percentage coverage of toner on a page. The estimate is
printed on a separate page at the end of each print job.

Note: Off is the factory default setting.

XPS menu

Use To

Print Error Pages
Off
On

Print a page containing information on errors, including XML markup errors.

Note: Off is the factory default setting.

PDF menu

Use To

Scale to Fit
Yes
No

Scale page content to fit the selected paper size.

Note: No is the factory default setting.
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Use To

Annotations
Do Not Print
Print

Print annotations in a PDF.

Note: Do Not Print is the factory default setting.

PostScript menu

Use To

Print PS Error
On
Off

Print a page containing the PostScript error.

Note: Off is the factory default setting.

Lock PS Startup Mode
On
Off

Disable the SysStart file.

Note: Off is the factory default setting.

Font Priority
Resident
Flash/Disk

Establish the font search order.

Notes:

• Resident is the factory default setting.

• This menu item is available only when a formatted flash memory option
card or printer hard disk is installed and operating properly.

• Make sure the flash memory option or printer hard disk is not
read/write‑, write‑, or password‑protected.

• Job Buffer Size must not be set to 100%.

PCL Emul menu

Use To

Font Source
Resident
Download
Flash
All

Specify the set of fonts used by the Font Name menu.

Notes:

• “Resident” is the factory default setting. “Resident” shows the factory
default set of fonts downloaded in the RAM.

• “Download” shows all the fonts downloaded in the RAM.

• “Flash” shows all fonts resident in that option. The optional flash memory
card must be properly formatted and cannot be read/write‑, write‑, or
password‑protected.

• “All” shows all fonts available to any option.

Font Name
Courier 10

Identify a specific font and the option where it is stored.

Note: Courier 10 is the factory default setting. Courier 10 shows the font
name, font ID, and the storage location in the printer. The font source
abbreviation is R for Resident, F for Flash, and D for Download.
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Symbol Set
10U PC‑8
12U PC‑850

Specify the symbol set for each font name.

Notes:

• 10U PC‑8 is the US factory default setting. 12U PC‑850 is the international
factory default setting.

• A symbol set is a set of alphabetic and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific program, such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size

1.00–1008.00

Change the point size for scalable typographic fonts.

Notes:

• 12 is the factory default setting.

• Point size refers to the height of the characters in the font. One point
equals approximately 0.014 inch.

• Point sizes can be increased or decreased in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100

Specify the font pitch for scalable monospaced fonts.

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01‑cpi increments.

• For nonscalable monospaced fonts, the pitch appears on the display but it
cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specify the orientation of text and graphics on the page.

Notes:

• Portrait is the factory default setting. Portrait prints text and graphics
parallel to the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.

PCL Emulation Settings
Lines per Page

1–255

Specify the number of lines that print on each page.

Notes:

• 60 is the US factory default setting. 64 is the international default setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the Paper Size
and Orientation you want before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Set the printer to print on A4‑size paper.

Notes:

• 198 mm is the factory default setting.

• The 203‑mm setting sets the width of the page to allow printing of eighty
10‑pitch characters.
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PCL Emulation Settings
Auto CR after LF

On
Off

Specify whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command.

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Note: Off is the factory default setting.

Tray Renumber
Assign MP Feeder

Off
None
0–199

Assign Tray [x]
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Manual Env
Off
None
0–199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Notes:

• Off is the factory default setting.

• None cannot be selected. It is only displayed when it is selected by the
PCL 5 interpreter. It also ignores the Select Paper Feed command.

• 0–199 allows a custom setting to be assigned.

Tray Renumber
View Factory Defaults

MPF Default = 8
T1 Default = 1
T1 Default = 4
T1 Default = 5
T1 Default = 20
T1 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Display the factory default setting assigned to each tray or feeder.

Tray Renumber
Restore Defaults

Yes
No

Restore all tray and feeder assignments to their factory default settings.
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HTML menu

Use To

Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text
Intl CG Times
Intl Courier
Intl Univers

Joanna MT
Letter Gothic
Lubalin Graph
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery
NewSansMTCS
NewSansMTCT
New SansMTJA
NewSansMTKO

Set the default font for HTML documents.

Note: The Times font is used in HTML documents that do not
specify a font.

Use To

Font Size
1–255 pt

Set the default font size for HTML documents.

Notes:

• 12 pt is the factory default setting.

• Font size can be increased in 1‑point increments.

Scale
1–400%

Scale the default font for HTML documents.

Notes:

• 100% is the factory default setting.

• Scaling can be increased in 1% increments.

Orientation
Portrait
Landscape

Set the page orientation for HTML documents.

Note: Portrait is the factory default setting.
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Use To

Margin Size
8–255 mm

Set the page margin for HTML documents.

Notes:

• 19 mm is the factory default setting.

• Margin size can be increased in 1‑mm increments.

Backgrounds
Do Not Print
Print

Specify whether to print backgrounds on HTML documents.

Note: Print is the factory default setting.

Image menu

Use To

Auto Fit
On
Off

Select the optimal paper size, scaling, and orientation.

Note: On is the factory default setting. It overrides scaling and orientation settings
for some images.

Invert
On
Off

Invert bitonal monochrome images.

Notes:

• Off is the factory default setting.

• This setting does not apply to GIF or JPEG images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scale the image to fit the selected paper size.

Notes:

• Best Fit is the factory default setting.

• When Auto Fit is set to On, Scaling is automatically set to Best Fit.

Orientation
Portrait
Landscape
Reverse Portrait
Reverse Landscape

Set the image orientation.

Note: Portrait is the factory default setting.

Help menu
The Help menu consists of a series of Help pages that are stored in the printer as PDFs. They contain information about
using the printer and performing printing tasks.

English, French, German, and Spanish translations are stored in the printer. Other translations are available at
http://support.lexmark.com.

Use To

Print All Guides Print all the guides.

Print Quality Print information about solving print quality issues.
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Use To

Printing Guide Print information about loading paper and other specialty media.

Media Guide Print a list of the paper sizes supported in trays and feeders.

Print Defects Guide Print information about resolving print defects.

Menu Map Print a list of the printer control panel menus and settings.

Information Guide Print a guide in locating additional information.

Connection Guide Print information about connecting the printer locally (USB) or to a network.

Moving Guide Print instructions for safely moving the printer.

Supplies Guide Print part numbers for ordering supplies.
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Saving money and the environment

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.

For information on how you can quickly save paper and energy using one printer setting, see "Using Eco-Mode".

Using recycled paper
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled
paper and other office papers” on page 43.

Conserving supplies

Use both sides of the paper

If your printer model supports duplex printing, then you can control whether print appears on one or two sides of the
paper by selecting 2‑sided printing from the Print dialog or from the Lexmark Toolbar.

Place multiple pages on one sheet of paper

You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper by
selecting a setting from the Multipage printing (N‑Up) section of the Print dialog screen.

Check your first draft for accuracy

Before printing or making multiple copies of a document:

• Use the preview feature, which you can select from the Print dialog or from the Lexmark Toolbar to see how the
document will look like before you print it.

• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams

Correctly set the paper type and size to avoid paper jams. For more information, see “Avoiding jams” on page 120.

Saving energy

Using Eco‑mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.

1 From the printer control panel, navigate to:
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 > Settings > Settings >  > General Settings >  > Eco‑Mode >  > select the setting you want

Use To

Off Use the factory default settings for all settings associated with Eco‑Mode. This setting supports the
performance specifications for your printer.

Energy Reduce energy use, especially when the printer is idle.

• Printer engine motors do not start until a job is ready to print. You may notice a short delay before
the first page is printed.

• The printer enters Sleep mode after one minute of inactivity.

Energy/Paper Use all the settings associated with Energy and Paper modes.

Plain Paper • Enable the automatic two‑sided (duplex) feature.

• Turn off print log features.

2 Press .

Reducing printer noise
Use Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:

 > Settings > Settings >  > General Settings >  > Quiet Mode > 

2 Select a setting you want.

Use To

On Reduce printer noise.

Notes:

• Print jobs will process at a reduced speed.

• Printer engine motors do not start until a document
is ready to print. There is a short delay before the
first page is printed.

Off Use factory default settings.

Note: This setting supports the performance
specifications of the printer.

3 Press .
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Adjusting Sleep mode
To save energy, decrease the number of minutes before the printer enters Sleep mode. Select from 1 to 120. The factory
default setting is 30 minutes.

Note: The printer still accepts print jobs when in Sleep mode.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Navigate to:

Settings > General Settings > Timeouts

3 In the Sleep Mode field, enter the number of minutes you want the printer to wait before it enters Sleep mode.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Sleep Mode > 

2 In the Sleep Mode field, select the number of minutes you want the printer to wait before it enters Sleep mode.

3 Press .

Using Hibernate mode
Hibernate is an ultra‑low‑power operating mode. When operating in Hibernate mode, all other systems and devices
are powered down safely.

Notes:

• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long press of
the Sleep button wakes the printer from Hibernate mode.

• The Hibernate mode can be scheduled. For more information, see “Using Schedule Power Modes” on page 104.

• If the printer is in Hibernate mode, the Embedded Web Server is disabled.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If your are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Sleep Button Settings.

3 From the “Press Sleep Button” or “Press and Hold Sleep Button” drop‑down menu, select Hibernate.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings > 

2 Press the arrow buttons until Press Sleep Button or Press and Hold Sleep Button appears, and

then press .

3 Press the arrow buttons until Hibernate appears, and then press .

Notes:

• When Press Sleep Button is set to Hibernate, a short press of the Sleep button sets the printer to Hibernate
mode.

• When Press and Hold Sleep Button is set to Hibernate, a long press of the Sleep button sets the printer to
Hibernate mode.

Setting Hibernate Timeout
Hibernate Timeout lets you set the amount of time the printer waits after a print job is processed before it goes into a
reduced power state.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Timeouts.

3 From the Hibernate Timeout menu, select the number of hours, days, weeks, or months you want for the printer
to wait before it goes into a reduced power state.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Hibernate Timeout > 

2 Select the amount of time the printer waits after a print job is processed before it enters Hibernate mode.
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3 Press .

Using Schedule Power Modes
Schedule Power Modes lets you schedule when the printer goes into a reduced power state or into the Ready state.

Note: This feature is available only in network printers or printers connected to print servers.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Schedule Power Modes.

3 From the Action menu, select the power mode.

4 From the Time menu, select the time.

5 From the Day(s) menu, select the day or days.

6 Click Add.

Adjusting the brightness of the printer display
To save energy, or if you have trouble reading the display, adjust its brightness settings.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings.

3 In the Screen Brightness field, enter the brightness percentage you want for the display.

4 Click Submit.

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter

• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

Saving money and the environment 104

http://www.lexmark.com/environment


• The Lexmark recycling program at www.lexmark.com/recycle

Recycling Lexmark products
To return Lexmark products for recycling:

1 Go to www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country or region from the list.

3 Follow the instructions on the computer screen.

Note: Printer supplies and hardware not listed in the Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Recycling Lexmark packaging
Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.

Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.

The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your
area.

When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling
Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both
easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent
of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return
the cartridges are also recycled.

To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Go to www.lexmark.com/recycle.

2 From the Toner Cartridges section, select your country or region.

3 Follow the instructions on the computer screen.
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Securing the printer

Using the security lock feature
The printer is equipped with a security lock feature. Attach a security lock compatible with most laptop computers in
the location shown to secure the printer in place.

Statement of Volatility
Your printer contains various types of memory that can store device and network settings, and user data.

Type of memory Description

Volatile memory Your printer uses standard random access memory (RAM) to
temporarily buffer user data during simple print jobs.

Non-volatile memory Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used to
store operating system, device settings, and network
information.

Erase the content of any installed printer memory in the following circumstances:

• The printer is being decommissioned.

• The printer is being moved to a different department or location.

• The printer is being serviced by someone from outside your organization.

• The printer is being removed from your premises for service.

• The printer is being sold to another organization.
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Erasing volatile memory
The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the buffered
data, turn off the printer.

Erasing non‑volatile memory
Erase individual settings, device and network settings, security settings, and embedded solutions by following these
steps:

1 Turn off the printer.

2 Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the screen with the
progress bar appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe All Settings appears.

The printer will restart several times during this process.

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the printer
memory.

4 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.

Finding printer security information
In high-security environments, it may be necessary to take additional steps to make sure that confidential data stored
in the printer cannot be accessed by unauthorized persons. For more information, visit the
Lexmark security Web page.

You can also see the Embedded Web Server Administrator’s Guide for additional information:

1 Go to http://support.lexmark.com, and then navigate to Software and Solutions > Other Applications.

2 Click the Manuals tab, and then select the Embedded Web Server Administrator’s Guide.
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Maintaining the printer
Warning—Potential Damage: Failure to maintain optimum printer performance, or to replace parts and supplies,
may cause damage to your printer.

Cleaning the printer

Cleaning the printer
Note: You may need to perform this task after every few months.

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the printer
warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

2 Remove paper from the standard bin and multipurpose feeder.

3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.

4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.

Warning—Potential Damage: Do not use household cleaners or detergents to prevent damage to the exterior
of the printer.

5 Make sure all areas of the printer are dry before sending a new print job.

Ordering supplies
To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies
dealers in your area. In other countries or regions, visit the Lexmark Web Site at www.lexmark.com or contact the
place where you purchased the printer.

Using genuine Lexmark parts and supplies
Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components. Use of third-party
supplies or parts can affect warranty coverage. Damage caused by the use of third-party supplies or parts is not covered
by the warranty. All life indicators are designed to function with Lexmark supplies and parts, and may deliver
unpredictable results if third-party supplies or parts are used. Imaging component usage beyond the intended life may
damage your Lexmark printer or its associated components.
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Ordering a toner cartridge

Notes:

• The estimated cartridge yield is based on approximately 5% coverage per page.

• Extremely low print coverage for extended periods of time may negatively affect actual yield.

Lexmark toner cartridge

Part name Part number

Toner Cartridge 24B6186

Ordering an imaging unit
Extremely low print coverage for extended periods of time may cause imaging unit parts to fail prior to exhaustion of
toner from toner cartridge.

For more information on replacing the imaging unit, see the instruction sheet that came with the supply.

Lexmark imaging unit

Part name Part number

Imaging unit 24B6040

Ordering a maintenance kit

Notes:

• Using certain types of paper may require more frequent replacement of the maintenance kit.

• The separator roller, fuser, pick roller assembly, transfer roller, and redrive assembly are all included in the
maintenance kit and can be individually ordered and replaced if necessary.

• Contact your service representative to replace the maintenance kit.

Recommended maintenance kits and part numbers

Printer model Part number

M3150de (100v) 40X8441

M3150de (110v) 40X8434

M3150de (220v) 40X8436

Estimated number of remaining pages
The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy may
vary significantly and is dependent on many factors, such as actual document content, print quality settings, and
other printer settings.
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The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption is
different from the historical printing consumption. Consider the variable level of accuracy before purchasing or replacing
supplies based on the estimate. Until an adequate print history is obtained on the printer, the estimated cartridge yield is
based on approximately 5% coverage per page.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust

Replacing supplies

Replacing the toner cartridge
1 Press the button on the right side of the printer, and then open the front door.

2

1
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2 Pull the toner cartridge out using the handle.

3 Unpack the toner cartridge, and then remove all packing materials.

4 Shake the new cartridge to redistribute the toner.

5 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

6 Close the front door.
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Replacing the imaging unit
1 Press the button on the right side of the printer, and then open the front door.

2

1

2 Pull the toner cartridge out using the handle.

3 Lift the green handle, and then pull the imaging unit out of the printer.
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4 Unpack the new imaging unit, and then shake it.

5 Remove all packing materials from the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

Warning—Potential Damage: Do not touch the photoconductor drum. Doing so may affect the print quality of
future print jobs.

6 Insert the imaging unit into the printer by aligning the arrows on the side rails of the imaging unit with the arrows
on the side rails inside the printer.
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7 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the side rails
inside the printer.

8 Close the front door.

Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.

• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on the
right side of the tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.
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Moving the printer to another location
The printer and its hardware options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer.

• Any cart used to move the hardware options must have a surface able to support the dimensions of the hardware
options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Managing the printer

Checking the virtual display
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Check the virtual display that appears at the top left corner of the screen.

The virtual display works as an actual display would work on a printer control panel.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, network, and supplies.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Reports, and then click the type of report you want to view.

Configuring supply notifications from the Embedded Web
Server
You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end‑of‑life by setting the selectable alerts.

Notes:

• Selectable alerts can be set on the toner cartridge, imaging unit, and maintenance kit.

• All selectable alerts can be set for nearly low, low, and very low supply conditions. Not all selectable alerts can
be set for the end‑of‑life supply condition. E‑mail selectable alert is available for all supply conditions.

• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for some
supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Supply Notifications.

3 From the drop‑down menu for each supply, select one of the following notification options:

Notification Description

Off The normal printer behavior for all supplies occurs.

E‑mail Only The printer generates an e-mail when the supply condition is reached. The status of the
supply will appear on the menus page and status page.

Warning The printer displays the warning message and generates an email about the status of the
supply. The printer does not stop when the supply condition is reached.

Continuable Stop1 The printer stops processing jobs when the supply condition is reached, and the user needs
to press a button to continue printing.

Non Continuable Stop1,2 The printer stops when the supply condition is reached. The supply must be replaced to
continue printing.

1 The printer generates an e-mail about the status of the supply when supply notification is enabled.
2 The printer stops when some supplies become empty to prevent damage.

4 Click Submit.

Modifying confidential print settings
Note: This feature is available only in network printers or printers connected to print servers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings tab > Security > Confidential Print Setup.

3 Modify the settings:

• Set a maximum number of PIN entry attempts. When a user exceeds a specific number of PIN entry attempts,
all of the jobs for that user are deleted.

• Set an expiration time for confidential print jobs. When a user has not printed the jobs within the specified time,
all of the jobs for that user are deleted.

4 Save the modified settings.

Copying printer settings to other printers
Note: This feature is available only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click the Copy Printer Settings.

3 To change the language, select a language from the drop-down menu, and then click Click here to submit language.

4 Click Printer Settings.

5 Type the IP addresses of the source and target printers in their appropriate fields.

Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.

6 Click Copy Printer Settings.

Creating a printer control panel PIN
The Panel PIN Protect menu lets you restrict access to the menus from the printer control panel. To restrict access to
the menus, create a Personal Identification Number (PIN), and then assign the PIN to each menu.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Security > Panel PIN Protect.

3 From the Create User PIN or Create Admin PIN sections, enter your PIN.

Note: Your can enter up to 16 digits for your PIN.

4 Click Modify.

5 From any menu in the Administrative Menus, Management, or Function Access sections, select User PIN
Protected or Admin PIN Protected or Admin PIN and User PIN Protected.

Note: Using an Admin PIN, you can still access a menu assigned with a User PIN.

6 Click Submit.

If you try to access a PIN‑protected menu from the printer control panel, the printer will require you to enter the PIN.

Note: After you enter the last digit of the PIN, make sure to press  on the printer control panel for more than
three seconds.
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Checking the status of parts and supplies
A message appears on the printer display when a replacement supply item is needed or when maintenance is required.

Checking the status of parts and supplies on the printer control panel
From the printer control panel, navigate to:

 > Status/Supplies >  View Supplies > 

Checking the status of parts and supplies from the Embedded Web Server
Note: Make sure the computer and printer are connected to the same network.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Device Status > More Details.

Restoring factory default settings
If you want to keep a list of the current menu settings for reference, then print a menu settings page before restoring
the factory default settings. For more information, see “Printing a menu settings page” on page 27.

If you want a more comprehensive method of restoring the printer factory default settings, then perform the Wipe All
Settings option. For more information, see “Erasing non‑volatile memory” on page 107.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
settings. Exceptions include the display language, custom sizes and messages, and network/port menu settings. All
downloads stored in the RAM are deleted. Downloads stored in the flash memory or in printer hard disk are not
affected.

From the printer control panel, navigate to:

 > Settings > Settings >  > General Settings >  > Factory Defaults >  > Restore Now > 
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Clearing jams
By carefully selecting paper and specialty media and loading it properly, you should be able to avoid most jams. If jams
occur, then follow the steps outlined in this chapter.

Warning—Potential Damage: Never use any tool to remove a jam. Doing so could permanently damage the fuser.

Avoiding jams

Load paper properly
• Make sure paper lies flat in the tray.

Correct loading of paper Incorrect loading of paper

• Do not remove a tray while the printer is printing.

• Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.

• Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.
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• Do not slide the paper into the tray. Load paper as shown in the illustration.

• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing tightly
against the paper or envelopes.

• Push the tray firmly into the printer after loading paper.

Use recommended paper
• Use only recommended paper or specialty media.

• Do not load wrinkled, creased, damp, bent, or curled paper.

• Flex, fan, and straighten paper before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same tray.

• Make sure the paper size and type are set correctly on the Embedded Web Server or the computer.

Note: Depending on your operating system, access the Paper menu using Local Printer Settings Utility or Printer
Settings.

• Store paper according to manufacturer recommendations.

Understanding jam messages and locations
When a jam occurs, a message indicating the jam location and information to clear the jam appears on the printer
display. Open the doors, covers, and trays indicated on the display to remove the jam.
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Notes:

• When Jam Assist is set to On, the printer automatically flushes blank pages or pages with partial prints to the
standard bin after a jammed page has been cleared. Check your printed output stack for discarded pages.

• When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, the Auto setting does not
guarantee that the page will print.

1

5

6

2

3

4

Area Printer control panel message What to do

1 Standard bin [x]‑page jam, clear standard
bin. [20y.xx]

Remove the jammed paper.

2 Rear door [x]‑page jam, open rear
door. [20y.xx]

Open the rear door, and then remove the jammed paper.

3 Tray 1 [x]‑page jam, remove tray 1 to
clear duplex. [23y.xx]

Pull tray 1 completely out, then push the front duplex flap
down, and then remove the jammed paper.

Note: You may need to open the rear door to clear
some 23y.xx paper jams.

4 Tray [x] [x]‑page jam, remove tray
[x]. [24y.xx]

Pull the indicated tray out, and then remove the jammed
paper.

5 Multipurpose
feeder

[x]‑page jam, clear manual
feeder. [250.xx]

Remove all paper from the multipurpose feeder, and then
remove the jammed paper.

6 Front door [x]‑page jam, open front
door. [20y.xx]

Open the front door, then remove the toner cartridge,
imaging unit, and jammed paper.
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[x]‑page jam, open front door. [20y.xx]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Press the button on the right side of the printer, and then open the front door.

2

1

2 Pull out the toner cartridge using the handle.

3 Lift the green handle, and then pull out the imaging unit from the printer.

Warning—Potential Damage: Do not touch the shiny blue photoconductor drum under the imaging unit. Doing
so may affect the quality of future print jobs.
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4 Place the imaging unit aside on a flat, smooth surface.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

5 Lift the green flap in front of the printer.

6 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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7 Insert the imaging unit by aligning the arrows on the side rails of the unit with the arrows on the side rails inside
the printer, and then insert the imaging unit into the printer.

8 Insert the toner cartridge by aligning the side rails of the cartridge with the arrows on the side rails inside the printer,
and then insert the cartridge into the printer.

9 Close the front door.

10 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, open rear door. [20y.xx]
1 Open the front door.

2

1

2 Gently pull down the rear door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

3 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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4 Close the rear door.

5 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, clear standard bin. [20y.xx]
1 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

2 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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[x]‑page jam, remove tray 1 to clear duplex. [23y.xx]
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Pull out the tray completely.

2 Locate the blue lever, and then pull it down to release the jam.

3 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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4 Insert the tray.

5 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, open tray [x]. [24y.xx]
1 Pull out the tray completely.

Note: The message on the printer display indicates the tray where the jammed paper is located.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Insert the tray.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.

[x]‑page jam, clear manual feeder. [25y.xx]
1 From the multipurpose feeder, firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

2 Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.
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3 Reload paper into the multipurpose feeder.

Note: Make sure the paper guide lightly rests against the edge of the paper.

4 From the printer control panel, select Next >  > Clear the jam, press OK >  to clear the message and continue
printing.
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Troubleshooting

Understanding the printer messages

Cartridge, imaging unit mismatch [41.xy]
1 Check if both the toner cartridge and imaging unit are MICR (Magnetic Ink Character Recognition) or non-MICR

supplies.

Note: For a list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.lexmark.com.

2 Change the toner cartridge or imaging unit so that both are MICR or non‑MICR supplies.

Notes:

• Use a MICR toner cartridge and imaging unit for printing checks and other similar documents.

• Use a non-MICR toner cartridge and imaging unit for regular print jobs.

Cartridge low [88.xy]

You may need to order a toner cartridge. If necessary, press  on the printer control panel to clear the message and
continue printing.

Cartridge nearly low [88.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.

Cartridge very low, [x] estimated pages remain [88.xy]
You may need to replace a toner cartridge very soon. For more information, see the “Replacing supplies” section of
the User’s Guide.

If necessary, press  on the printer control panel to clear the message and continue printing.

Change [paper source] to [custom type name] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.
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Change [paper source] to [custom string] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [paper type] [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the printer control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Close front door
Close the front door of the printer.

Complex page, some data may not have printed [39]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Reduce the number and size of fonts, the number and complexity of images, and the number of pages in the print
job.

• Cancel the print job.

• Install additional printer memory.

Configuration change, some held jobs were not restored [57]
Held jobs are unavailable because of any of the following possible changes in the printer:

• The printer firmware has been updated.

• The tray for the print job is removed.
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• The print job is sent from a flash drive that is no longer attached to the USB port.

• The printer hard disk contains print jobs that were stored when the hard disk was installed in a different printer
model.

From the printer control panel, press  to clear the message and continue printing.

Defective flash detected [51]
Try one or more of the following:

• Replace the defective flash memory card.

• From the printer control panel, press  to ignore the message and continue printing.

• Cancel the current print job.

Error reading USB drive. Remove USB.
An unsupported USB device is inserted. Remove the USB device, and then insert a supported one.

Error reading USB hub. Remove hub.
An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one.

Imaging unit low [84.xy]

You may need to order an imaging unit. If necessary, press  on the printer control panel to clear the message and
continue printing.

Imaging unit nearly low [84.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.

Imaging unit very low, [x] estimated pages remain [84.xy]
You may need to replace the imaging unit very soon. For more information, see the “Replacing supplies” section of the
User’s Guide.

If necessary, press  on the printer control panel to clear the message and continue printing.

Incorrect paper size, open [paper source] [34]
Try one or more of the following:

• Load the correct size of paper in the tray.

• From the printer control panel, press  to clear the message and print using a different tray.
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• Check the tray length and width guides and make sure the paper is loaded properly in the tray.

• Make sure the correct paper size and type are specified in Print Properties or in the Print dialog.

• Make sure the paper size and type settings are specified in the Paper menu on the printer control panel.

• Make sure the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, then make sure the
paper is large enough for the data being printed.

• Cancel the print job.

Insert Tray [x]
Insert the indicated tray into the printer.

Insufficient memory to support Resource Save feature [35]
Try one or more of the following:

• From the printer control panel, press  to disable Resource Save, clear the message, and continue printing.

• Install additional printer memory.

Insufficient memory to collate job [37]
Try one or more of the following:

• From the printer control panel, press  to print the portion of the job already stored and begin collating the rest
of the print job.

• Cancel the current print job.

Insufficient memory for Flash Memory Defragment operation [37]
Try one or more of the following:

• From the printer control panel, press  to stop the defragmentation and continue printing.

• Delete fonts, macros, and other data in the printer memory. From the printer control panel, navigate to:

 > Settings >  > Settings >  >Print Settings >  > Utilities Menu >  > Format Flash >  > Yes >

• Install additional printer memory.

Insufficient memory, some Held Jobs were deleted [37]

From the printer control panel, press  to clear the message.
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Insufficient memory, some held jobs will not be restored [37]
Do either of the following:

• From the printer control panel, press  to clear the message.

• Delete other held jobs to free up additional printer memory.

Load [paper source] with [custom string] [orientation]
Try one or more of the following:

• Load the indicated tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [custom type name] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper size, then it feeds from that tray. If the printer cannot
find a tray that has the correct size of paper, then it prints from the default paper source.

• Cancel the current job.
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Load [paper source] with [paper type] [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that tray. If the
printer cannot find a tray that has the correct size and type of paper, then it prints from the default paper
source.

• Cancel the current job.

Load Manual Feeder with [custom type name] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Load Manual Feeder with [custom string] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Load Manual Feeder with [paper size] [orientation]
Try one or more of the following:

• Load the feeder with the correct size of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.
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Load Manual Feeder with [paper type] [paper size] [orientation]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the feeder, then the printer manually overrides the request, and then prints from
an automatically selected tray.

• Cancel the current job.

Maintenance kit low [80.xy]
You may need to order a maintenance kit. For more information, visit the Lexmark Web site at

http://support.lexmark.com or contact customer support, and then report the message. If necessary, press  on
the printer control panel to clear the message and continue printing.

Maintenance kit nearly low [80.xy]
For more information, visit the Lexmark Web site at http://support.lexmark.com or contact customer support, and

then report the message. If necessary, press  on the printer control panel to clear the message and continue
printing.

Maintenance kit very low, [x] estimated pages remain [80.xy]
You may need to replace the maintenance kit very soon. For more information, visit the Lexmark Web site at
http://support.lexmark.com or contact customer support, and then report the message.

If necessary, press  on the printer control panel to clear the message and continue printing.

Memory full [38]
Try one or more of the following:

• From the printer control panel, press  to clear the message.

• Decrease the resolution setting.

• Install additional printer memory.

Network [x] software error [54]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Unplug the router, then wait for 30 seconds, and then plug it back again.
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• Turn off the printer, wait for about 10 seconds, and then turn the printer back on.

• Update the network firmware in the printer or the print server. For more information, visit the Lexmark Web site
at http://support.lexmark.com.

Non‑Lexmark [supply type], see User’s Guide [33.xy]
Note: The supply type can either be a toner cartridge or imaging unit.

The printer has detected a non‑Lexmark supply or part installed in the printer.

Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components.

All life indicators are designed to function with Lexmark supplies and parts, and may deliver unpredictable results if
third-party supplies or parts are used. Imaging component usage beyond the intended life may damage your Lexmark
printer or associated components. 

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage caused by
the use of third-party supplies or parts are not covered by the warranty.

To accept any and all of these risks and to proceed with the use of non-genuine supplies or parts in your printer,

press  and  on the printer control panel simultaneously for 15 seconds to clear the message and continue
printing.

If you do not wish to accept these risks, then remove the third‑party supply or part from your printer, and then install
a genuine Lexmark supply or part.

Note: For the list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.lexmark.com.

Not enough free space in flash memory for resources [52]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Delete fonts, macros, and other data stored in the flash memory.

From the printer control panel, navigate to:

 > Settings >  > Settings >  > Print Settings >  > Utilities Menu >  > Format Flash >  >

Yes > 

• Use a larger‑capacity flash memory card.

Note: Downloaded fonts and macros that are not stored in the flash memory are deleted when the printer is turned
off or restarted.

Printer had to restart. Last job may be incomplete.
From the printer control panel, select Continue to clear the message and continue printing.

For more information, visit http://support.lexmark.com or contact customer support.
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Reinstall missing or unresponsive cartridge [31.xy]
Try one or more of the following:

• Check if the toner cartridge is missing. If missing, install the toner cartridge.

For information on installing the cartridge, see the “Replacing supplies” section of the User’s Guide.

• If the toner cartridge is installed, then remove the unresponsive toner cartridge, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the cartridge is defective. Replace the toner
cartridge.

Reinstall missing or unresponsive imaging unit [31.xy]
Try one or more of the following:

• Check if the imaging unit is missing. If missing, install the imaging unit.

For information on installing the imaging unit, see the “Replacing supplies” section of the User’s Guide.

• If the imaging unit is installed, then remove the unresponsive imaging unit, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the imaging unit is defective. Replace the
imaging unit.

Remove paper from standard output bin
Remove the paper stack from the standard bin.

Replace cartridge, 0 estimated pages remain [88.xy]
Replace the toner cartridge to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace cartridge, printer region mismatch [42.xy]
Install a toner cartridge that matches the region number of the printer. x indicates the value of the printer region. y
indicates the value of the cartridge region. x and y can have the following values:

List of printer and toner cartridge regions

Region number Region

0 Global

1 United States, Canada

2 European Economic Area (EEA), Switzerland

3 Asia Pacific, Australia, New Zealand

4 Latin America

5 Africa, Middle East, rest of Europe

Troubleshooting 140

http://www.lexmark.com


Region number Region

9 Invalid

Notes:

• The x and y values are the .xy of the error code shown on the printer control panel.

• The x and y values must match for printing to continue.

Replace imaging unit, 0 estimated pages remain [84.xy]
Replace the imaging unit to clear the message and continue printing. For more information, see the instruction sheet
that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace maintenance kit, 0 estimated pages remain [80.xy]
Visit the Lexmark Web site at http://support.lexmark.com or contact customer support, and then report the message.
The printer is scheduled for maintenance.

Replace unsupported cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace unsupported imaging unit [32.xy]
Remove the imaging unit, and then install a supported one to clear the message and continue printing. For more
information, see the instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s
Guide.

Note: If you do not have a replacement imaging unit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Serial option [x] error [54]
Try one or more of the following:

• Make sure that the serial cable is properly connected and is the correct one for the serial port.

• Make sure that the serial interface parameters (protocol, baud, parity, and data bits) are set correctly on the printer
and computer.

• From the printer control panel, press  to continue printing.

• Turn off the printer, and then turn it back on.
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SMTP server not set up. Contact system administrator.

From the printer control panel, press  to clear the message.

Note: If the message appears again, then contact your system support person.

Standard network software error [54]
Try one or more of the following:

• From the printer control panel, press  to confirm.

• Unplug the router, then wait for 30 seconds, and then plug it back again.

• Turn off the printer, and then turn it back on.

• Update the network firmware in the printer or the print server. For more information, visit the Lexmark Web site
at http://support.lexmark.com.

Standard parallel port disabled [56]

• From the printer control panel, press  to clear the message.

Notes:

• The printer discards any data received through the parallel port.

• Make sure the Parallel Buffer menu is not set to Disabled.

Standard USB port disabled [56]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

Note: The printer discards any data received through the USB port.

• From the printer control panel, set USB Buffer to Auto.

Too many flash options installed [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra flash memory.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.
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Too many trays attached [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra trays.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Unformatted flash detected [53]
Try one or more of the following:

• From the printer control panel, press  to stop the defragmentation and continue printing.

• Format the flash memory device.

Note: If the error message remains, then the flash memory device may be defective and need to be replaced.

Unsupported option in slot [x] [55]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the unsupported option card from the printer controller board, and then replace it with a supported card.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Weblink server not set up. Contact system administrator.

From the printer control panel, press  to clear the message.

Note: If the message appears again, then contact your system support person.

Solving printer problems
• “Basic printer problems” on page 144

• “Option problems” on page 146

• “Paper feed problems” on page 148
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Basic printer problems

The printer is not responding

Action Yes No

Step 1

Make sure the printer is turned on.

Is the printer turned on?

Go to step 2. Turn on the printer.

Step 2

Check if the printer is in Sleep mode or Hibernate mode.

Is the printer in Sleep mode or Hibernate mode?

Press the Sleep button
to wake the printer
from Sleep mode or
Hibernate mode.

Go to step 3.

Step 3

Check if one end of the power cord is plugged into the printer and the
other to a properly grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 4. Plug one end of the
power cord into the
printer and the other to
a properly grounded
electrical outlet.

Step 4

Check other electrical equipment plugged into the electrical outlet.

Does other electrical equipment work?

Unplug the other
electrical equipment,
and then turn on the
printer. If the printer
does not work, then
reconnect the other
electrical equipment.

Go to step 5.

Step 5

Check if the cables connecting the printer and the computer are inserted
in the correct ports.

Are the cables inserted in the correct ports?

Go to step 6. Make sure to match the
following:

• The USB symbol on
the cable with the
USB symbol on the
printer

• The appropriate
Ethernet cable with
the Ethernet port

Step 6

Make sure the electrical outlet is not turned off by a switch or breaker.

Is the electrical outlet turned off by a switch or breaker?

Turn on the switch or
reset the breaker.

Go to step 7.

Step 7

Check if the printer is plugged into any surge protectors, uninterruptible
power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?

Connect the printer
power cord directly to
a properly grounded
electrical outlet.

Go to step 8.
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Action Yes No

Step 8

Check if one end of the printer cable is plugged into a port on the printer
and the other to the computer, print server, option, or other network
device.

Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?

Go to step 9. Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Step 9

Make sure to install all hardware options properly and remove any packing
material.

Are all hardware options properly installed and all packing material
removed?

Go to step 10. Turn off the printer,
remove all packing
materials, then
reinstall the hardware
options, and then turn
on the printer.

Step 10

Check if you have selected the correct port settings in the printer driver.

Are the port settings correct?

Go to step 11. Use correct printer
driver settings.

Step 11

Check the installed printer driver.

Is the correct printer driver installed?

Go to step 12. Install the correct
printer driver.

Step 12

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Is the printer working?

The problem is solved. Contact customer
support.

Printer display is blank

Action Yes No

Step 1

Press the Sleep button on the printer control panel.

Does Ready appear on the printer display?

The problem is solved. Go to step 2.

Step 2

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Do Please wait and Ready appear on the printer display?

The problem is solved. Turn off the printer,
and then contact
customer support.
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Option problems

Cannot detect internal option

Action Yes No

Step 1

Turn off the printer, then wait for about 10 seconds, and then turn on the
printer.

Does the internal option operate correctly?

The problem is solved. Go to step 2.

Step 2

Check if the internal option is properly installed in the controller board.

a Turn off the printer using the power switch, and then unplug the power
cord from the electrical outlet.

b Make sure the internal option is installed in the appropriate connector
in the controller board.

c Connect the power cord to the printer, then to a properly grounded
electrical outlet, and then turn on the printer.

Is the internal option properly installed in the controller board?

Go to step 3. Connect the internal
option to the controller
board.

Step 3

Print a menu settings page, and then check to see if the internal option is
listed in the Installed Features list.

Is the internal option listed in the menu settings page?

Go to step 4. Reinstall the internal
option.

Step 4

a Check if the internal option is selected.

It may be necessary to manually add the internal option in the printer
driver to make it available for print jobs. For more information, see
“Updating available options in the printer driver” on page 21.

b Resend the print job.

Does the internal option operate correctly?

The problem is solved. Contact customer
support.

Troubleshooting 146



Tray problems

Action Yes No

Step 1

a Open the tray and do one or more of the following:

• Check for paper jams or misfeeds.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• If you are printing on custom‑size paper, then make sure that the
paper guides rest against the edges of the paper.

• Make sure the paper is below the maximum paper fill indicator.

• Make sure paper lies flat in the tray.

b Check if the tray closes properly.

Is the tray working?

The problem is solved. Go to step 2.

Step 2

a Turn off the printer, then wait about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Is the tray working?

The problem is solved. Go to step 3.

Step 3

Check if the tray is installed.
Print a menu settings page, and then check if the tray is listed in the
Installed Options list.

Is the tray listed in the menu settings page?

Go to step 4. Reinstall the tray. For
more information, see
the setup
documentation that
came with the tray.

Step 4

Check if the tray is available in the printer driver.

Note: If necessary, manually add the tray in the printer driver to make it
available for print jobs. For more information, see “Updating available
options in the printer driver” on page 21.

Is the tray available in the printer driver?

Go to step 5. Manually add the tray
in the printer driver.

Step 5

Check if the option is selected.

a From the application you are using, select the option. For Mac OS X
version 9 users, make sure the printer is set up in Chooser.

b Resend the print job.

Is the tray working?

The problem is solved. Contact customer
support.
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Paper feed problems

Paper frequently jams

Action Yes No

Step 1

a Pull out the tray, and then do one or more of the following:

• Make sure paper lies flat in the tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of the
paper.

• Make sure the paper is below the maximum paper fill indicator.

• Check if you are printing on a recommended paper size and type.

b Insert the tray properly.

If jam recovery is enabled, then the print jobs will reprint
automatically.

Do paper jams still occur frequently?

Go to step 2. The problem is solved.

Step 2

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do paper jams still occur frequently?

Go to step 3. The problem is solved.

Step 3

a Review the tips on avoiding jams. For more information, see “Avoiding
jams” on page 120.

b Follow the recommendations, and then resend the print job.

Do paper jams still occur frequently?

Contact customer
support.

The problem is solved.

Paper jam message remains after jam is cleared

Action Yes No

a From the printer control panel, navigate to:

Next >  > Clear the jam, press OK > 

b Follow the instructions on the printer display.

Does the paper jam message remain?

Contact customer
support.

The problem is solved.
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Jammed pages are not reprinted

Action Yes No

a Turn on jam recovery.

1 From the printer control panel, navigate to:

Settings > General Settings > Print Recovery > Jam Recovery

2 Select On or Auto, and then press .

b Resend the pages that did not print.

Were the jammed pages reprinted?

The problem is solved. Contact customer
support.

Solving print problems

Printing problems

Multiple‑language PDF files do not print

Action Yes No

Step 1

a Check if the print options for the PDF output are set to embed all fonts.

b Generate a new PDF file, and then resend the print job.

Do the files print?

The problem is solved. Go to step 2.

Step 2

a Open the document you want to print in Adobe Acrobat.

b Click File > Print > Advanced > Print As Image > OK > OK .

Do the files print?

The problem is solved. Contact customer
support.

Print jobs do not print

Action Yes No

Step 1

a From the document you are trying to print, open the Print dialog and
check if you have selected the correct printer.

Note: If the printer is not the default printer, then you must select
the printer for each document that you want to print.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

a Check if the printer is plugged in and turned on, and if Ready appears
on the printer display.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 3.

Step 3

If an error message appears on the printer display, then clear the message.

Note: The printer continues to print after clearing the message.

Do the jobs print?

The problem is solved. Go to step 4.

Step 4

a Check if the ports (USB, serial, or Ethernet) are working and if the
cables are securely connected to the computer and the printer.

Note: For more information, see the setup documentation that
came with the printer.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 5.

Step 5

a Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 6.

Step 6

a Remove, and then reinstall the printer software. For more
information, see “Installing the printer software” on page 20.

Note: The printer software is available at
http://support.lexmark.com.

b Resend the print job.

Do the jobs print?

The problem is solved. Contact customer
support.
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Confidential and other held jobs do not print

Note: Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

Action Yes No

Step 1

Open the held jobs folder on the printer display, and then verify that your
print job is listed.

Is your print job listed in the held jobs folder?

Go to step 2. Select one of the Print
and Hold options, and
then resend the print
job. For more
information, see
“Printing confidential
and other held jobs” on
page 49.

Step 2

The print job may contain a formatting error or invalid data.

• Delete the print job, and then send it again.

• For PDF files, generate a new PDF, and then print it again.

If you are printing from the Internet, then the printer may be reading
multiple job titles as duplicates and deleting all jobs except the first one.

For Windows users

a Open the Print Properties folder.

b From the Print and Hold dialog, select the “Keep duplicate documents”
check box.

c Enter a PIN number.

For Macintosh users

Save each print job, name each job differently, and then send the
individual jobs to the printer.

Does the job print?

The problem is solved. Go to step 3.

Step 3

Free up additional printer memory by deleting some of the held jobs.

Does the job print?

The problem is solved. Add additional printer
memory.
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Print job takes longer than expected

Action Yes No

Step 1

Change the environmental settings of the printer.

a From the printer control panel, navigate to:

Settings > General Settings

b Select Eco‑Mode or Quiet Mode, and then select Off.

Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.

Did the job print?

The problem is solved. Go to step 2.

Step 2

Reduce the number and size of fonts, the number and complexity of
images, and the number of pages in the print job, and then resend the job

Did the job print?

The problem is solved. Go to step 3.

Step 3

a Remove held jobs stored in the printer memory.

b Resend the print job.

Did the job print?

The problem is solved. Go to step 4.

Step 4

a Disable the Page Protect feature.

From the printer control panel, navigate to:

Settings > General Settings > Print Recovery > Page Protect > Off

b Resend the print job.

Did the job print?

The problem is solved. Go to step 5.

Step 5

Install additional printer memory, and then resend the print job.

Did the job print?

The problem is solved. Contact customer
support.

Job prints from the wrong tray or on the wrong paper

Action Yes No

Step 1

a Check if you are printing on paper that is supported by the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

a From the Paper menu on the printer control panel, set the paper size
and type to match the paper loaded in the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 3.

Step 3

a Depending on your operating system, open Printing Preferences or
the Print dialog, and then specify the paper type.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 4.

Step 4

a Check if the trays are not linked.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Contact customer
support.

Incorrect characters print

Action Yes No

Step 1

Make sure the printer is not in Hex Trace mode.

Note: If Ready Hex appears on the printer display, then turn off the
printer, and then turn it back on to deactivate Hex Trace mode.

Is the printer in Hex Trace mode?

Deactivate Hex Trace
mode.

Go to step 2.

Step 2

a From the printer control panel, select Standard Network or
Network [x], and then set SmartSwitch to On.

b Resend the print job.

Do incorrect characters print?

Contact customer
support.

The problem is solved.

Tray linking does not work

Note: The trays and the multipurpose feeder do not automatically detect the paper size. You must set the size from
the Paper Size/Type menu.
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Action Yes No

a From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the trays to be linked.

Note: The paper size and type must match for trays to be linked.

b Resend the print job.

Do the trays link correctly?

The problem is solved. Contact customer
support.

Large jobs do not collate

Action Yes No

Step 1

a From the Finishing menu on the printer control panel, set Collate to
(1,2,3) (1,2,3).

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 2.

Step 2

a From the printer software, set Collate to (1,2,3) (1,2,3).

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides the
setting in the Finishing menu.

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 3.

Step 3

Reduce the complexity of the print job by eliminating the number and size
of fonts, the number and complexity of images, and the number of pages
in the job.

Did the job print and collate correctly?

The problem is solved. Contact customer
support.

Unexpected page breaks occur

Action Yes No

Step 1

Adjust the print timeout settings.

a From the printer control panel, navigate to:

Settings > General Settings > Timeouts > Print Timeout

b Select a higher setting and then, depending on your printer model,

select  or Submit.

c Resend the print job.

Did the file print correctly?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

a Check the original file for manual page breaks.

b Resend the print job.

Did the file print correctly?

The problem is solved. Contact customer
support.

Print quality problems

Characters have jagged or uneven edges

Action Yes No

Step 1

a Print a font sample list to check if the fonts you are using are supported
by the printer.

1 From the printer control panel, navigate to:

Menus > Reports > Print Fonts

2 Select PCL Fonts or PostScript Fonts.

b Resend the print job.

Are you using fonts that are supported by the printer?

Go to step 2. Select a font that is
supported by the
printer.

Step 2

Check if the fonts installed on the computer are supported by the printer.

Are the fonts installed on the computer supported by the printer?

The problem is solved. Contact customer
support.
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Clipped pages or images

Leading edge

Trailing edge

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper loaded.

b Resend the print job.

Is the page or image clipped?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Do the paper size and type match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Is the page or image clipped?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge.

2 Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the page or image clipped?

Contact customer
support.

The problem is solved.
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Shadow images appear on prints

ABCD
ABCD
ABCD
ABCD

Leading edge

Trailing edge

Action Yes No

Step 1

Load paper with the correct paper type and weight in the tray.

Is paper with the correct paper type and weight loaded in the tray?

Go to step 2. Load paper with the
correct paper type and
weight in the tray.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Is the tray set to the type and weight of the paper loaded?

Go to step 3. Change the paper
loaded in the tray to
match the paper type
and weight specified in
the tray settings.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do shadow images still appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging unit, and then resend the print job.

Do shadow images still appear on prints?

Contact customer
support.

The problem is solved.
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Gray background on prints

ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a From the Quality Menu on the printer control panel, decrease the
toner darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Go to step 2.

Step 2

Reinstall the imaging unit and the toner cartridge.

a Remove the toner cartridge.

b Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to light
can cause print quality problems.

c Install the imaging unit, and then the cartridge.

d Resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Go to step 3.

Step 3

Replace the imaging unit, and then resend the print job.

Did the gray background disappear from the prints?

The problem is solved. Contact customer
support.
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Incorrect margins on prints

ABCD
ABCD
ABCD

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper size loaded.

b Resend the print job.

Are the margins correct?

The problem is solved. Go to step 2.

Step 2

From the printer control panel, set the paper size in the Paper menu to
match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Are the margins correct?

The problem is solved. Contact customer
support.
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Paper curl

Action Yes No

Step 1

Move the width and length guides in the tray to the correct positions for
the size of the paper loaded.

Are the width and length guides positioned correctly?

Go to step 2. Adjust the width and
length guides.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the paper in
the tray?

Go to step 3. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the paper still curled?

Go to step 4. The problem is solved.

Step 4

a Remove the paper from the tray, and then turn it over.

b Resend the print job.

Is the paper still curled?

Go to step 5. The problem is solved.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the paper still curled?

Contact customer
support.

The problem is solved.
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Print irregularities

) )ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded in the tray.

b Resend the print job.

Do print irregularities still appear?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Do the printer settings match the type and weight of the paper loaded in
the tray?

Go to step 3. Specify the paper size
and type from the tray
settings to match the
paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do print irregularities still appear?

Go to step 4. The problem is solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do print irregularities still appear?

Go to step 6. The problem is solved.

Step 6

Replace the imaging unit, and then resend the print job.

Do print irregularities still appear?

Contact customer
support at
http://support.lexmar
k.com or your service
representative.

The problem is solved.
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Repeating defects appear on prints

Action Yes No

Step 1

Measure the distance between the defects.
Check for a distance between the defects that equals:

• 97 mm (3.82 in.)

• 47 mm (1.85 in.)

• 38 mm (1.5 in.)

Is the distance between defects equal to one of the listed measurements?

Go to step 2. 1 Check if the
distance between
the defects equal
to 80 mm (3.15 in.)

2 Take note of the
distance, and then
contact customer
support at
 http://support.le
xmark.com or
your service
representative.

Step 2

Replace the imaging unit, and then resend the print job.

Do the repeating defects still appear?

Contact customer
support at
 http://support.lexma
rk.com or your service
representative.

The problem is solved.

Print is too dark

Action Yes No

Step 1

a From the Quality menu on the printer control panel, reduce the toner
darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too dark?

Go to step 2. The problem is solved.

Troubleshooting 162

http://support.lexmark.com/
http://support.lexmark.com/
http://support.lexmark.com/
http://support.lexmark.com/


Action Yes No

Step 2

a From the printer control panel, set the paper type, texture and weight
in the Paper menu to match the paper loaded in the tray.

b Resend the print job.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Do one or more of the
following:

• Specify the paper
type, texture, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
type, texture and
weight specified in
the tray settings.

Step 3

a Depending on your operating system, specify the paper type, texture
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too dark?

Go to step 4. The problem is solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too dark?

Go to step 6. The problem is solved.

Step 6

Replace the imaging unit, and then resend the print job.

Is the print still too dark?

Contact customer
support.

The problem is solved.

Troubleshooting 163



Print is too light

Action Yes No

Step 1

a From the Quality menu on the printer control panel, increase the toner
darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too light?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper type, texture, and weight in
the Paper menu to match the paper loaded in the tray.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Change the paper type,
texture, and weight to
match the paper
loaded in the tray.

Step 3

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too light?

Go to step 4. The problem is solved.

Step 4

Make sure that the paper has no texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, change
the texture settings in
the Paper Texture
menu to match the
paper you are printing
on.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too light?

Go to step 6. The problem is solved.
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Action Yes No

Step 6

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the print still too light?

Go to step 7. The problem is solved.

Step 7

Replace the imaging unit, and then resend the print job.

Is the print still too light?

Contact customer
support.

The problem is solved.

Printer is printing blank pages

Action Yes No

Step 1

a Check if there is packing material left on the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Check if the packing material is properly removed from the imaging
unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 3. The problem is solved.

Step 3

Replace the imaging unit, and then resend the print job.

Is the printer still printing blank pages?

Contact customer
support.

The problem is solved.

Skewed print

)
)ABCDE

ABCDEABCDE

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded.

b Resend the print job.

Is the print still skewed?

Go to step 2. The problem is solved.

Step 2

a Check if you are printing on a paper that is supported by the tray.

b Resend the print job.

Is the print still skewed?

Contact customer
support.

The problem is solved.
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Printer is printing solid black pages

Action Yes No

Step 1

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer printing solid black pages?

Go to step 2. The problem is solved.

Step 2

Replace the imaging unit, and then resend the print job.

Is the printer printing solid black pages?

Contact customer
support.

The problem is solved.

Transparency print quality is poor

Action Yes No

Step 1

From the printer control panel, set the paper type in the Paper menu to
match the paper loaded in the tray.

Is the paper type for the tray set to Transparency?

Go to step 2. Set the paper type to
Transparency.

Step 2

a Check if you are using a recommended type of transparency.

b Resend the print job.

Is the print quality still poor?

Contact customer
support.

The problem is solved.
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Streaked horizontal lines appear on prints

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Depending on your operating system, specify the tray or feeder from
Printing Preferences or the Print dialog.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the paper in
the tray?

Go to step 3. Change the paper type
and weight to match
the paper loaded in the
tray.

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked horizontal lines appear on prints?

Contact customer
support.

The problem is solved.
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Streaked vertical lines appear on prints

ABCDE
ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper texture, type, and weight in
the Paper menu to match the paper loaded in the tray.

Do the paper texture, type, and weight match the paper in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
texture, type, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
texture, type, and
weight specified in
the tray settings.

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 5. The problem is solved.
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Action Yes No

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked vertical lines appear on prints?

Contact customer
support at
http://support.lexmar
k.com or your service
representative.

The problem is solved.

Horizontal voids appear on prints

Leading edge

Trailing edge

Action Yes No

Step 1

a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 2. The problem is solved.

Step 2

a Load the specified tray or feeder with a recommended type of paper.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 3. The problem is solved.

Step 3

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging unit, and then resend the print job.

Do horizontal voids appear on prints?

Contact customer
support.

The problem is solved.
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Vertical voids appear on prints

Leading edge

Trailing edge

Action Yes No

Step 1

a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 2. The problem is solved.

Step 2

a From the printer control panel, set the paper type and weight in the
Paper menu to match the paper loaded in the tray.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 3. The problem is solved.

Step 3

Check if you are using a recommended type of paper.

a Load the indicated tray or feeder with a recommended type of paper.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 4. The problem is solved.

Step 4

a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do vertical voids appear on prints?

Contact customer
support.

Note: The laser
scanning unit may be
defective.

The problem is solved.
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Toner specks appear on prints

Action Yes No

Replace the imaging unit, and then resend the print job.

Do toner specks appear on prints?

Contact customer
support.

The problem is solved.

Toner fog or background shading appears on prints

ABCDE

ABCDE
ABCDE

Action Yes No

Step 1

Reinstall the imaging unit.

a Remove, and then install the imaging unit.

b Resend the print job.

Does fog or shading appear on prints?

Go to step 2. The problem is solved.

Step 2

Replace the imaging unit, and then resend the print job.

Does fog or shading appear on prints?

Contact customer
support at
http://support.lexmar
k.com  or your service
representative.

The problem is solved.
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Toner rubs off

Leading edge

Trailing edge

ABC

DEF

Action Yes No

Step 1

From the Paper menu on the printer control panel, check the paper type
and weight.

Do the paper type and texture match the paper loaded in the tray?

Go to step 2. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 2

Check if you are printing on paper with texture or rough finishes.

Are you printing on textured or rough paper?

From the Paper menu
on the printer control
panel, set the paper
texture.

Contact customer
support.

Uneven print density

Action Yes No

Replace the imaging unit, and then resend the print job.

Is the print density uneven?

Contact customer
support.

The problem is solved.

Embedded Web Server does not open
Action Yes No

Step 1

a Turn on the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 2.
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Action Yes No

Step 2

Make sure the printer IP address is correct.

a View the printer IP address:

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then
finding the TCP/IP section

Note: An IP address appears as four sets of numbers separated
by periods, such as 123.123.123.123.

b Open a Web browser, and then type the IP address.

Note: Depending on the network settings, you may need to type
“https://” instead of “http://” before the printer IP address
to access the Embedded Web Server.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 3.

Step 3

Check if the network is working.

a Print a network setup page.

b Check the first section of the network setup page and confirm that the
status is Connected.

Note: If the status is Not Connected, then the connection may be
intermittent, or the network cable may be defective. Contact your
system support person for a solution, and then print another
network setup page.

c Open a Web browser, and then type the printer IP address.

d Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 4.

Step 4

Check if the cable connections to the printer and print server are secure.

a Connect the cables properly. For more information, see the setup
documentation that came with the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 5.

Step 5

Temporarily disable the Web proxy servers.
Proxy servers may block or restrict you from accessing certain Web
sites including the Embedded Web Server.

Does the Embedded Web Server open?

The problem is solved. Contact your system
support person.
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Contacting customer support
When you contact customer support, describe the problem you are experiencing, the message on the printer display,
and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label on the inside top
front cover or at the back of the printer. The serial number is also listed on the menu settings page.

Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:

Tech Library You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.

E-mail You can send an e-mail to the Lexmark team, describing your problem. A service representative will respond
and provide you with information to solve your problem.

Live chat You can chat directly with a service representative. They can work with you to solve your printer problem or
provide assistance through Assisted Service where the service representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit the
Lexmark Web site at http://support.lexmark.com.
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Notices

Product information

Product name:

Lexmark M3150dn

Machine type:

4514

Model(s):

638

Edition notice

December 2012

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

© 2012 Lexmark International, Inc.

All rights reserved.

GOVERNMENT END USERS

The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.

Notices 176

http://support.lexmark.com
http://www.lexmark.com


Trademarks

Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc., registered in
the United States and/or other countries.

PrintCryption is a trademark of Lexmark International, Inc.

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.

PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.

The following terms are trademarks or registered trademarks of these companies:

Albertus The Monotype Corporation plc

Antique Olive Monsieur Marcel OLIVE

Apple-Chancery Apple Computer, Inc.

Arial The Monotype Corporation plc

CG Times Based on Times New Roman under license from The Monotype Corporation plc, is a product of
Agfa Corporation

Chicago Apple Computer, Inc.

Clarendon Linotype-Hell AG and/or its subsidiaries

Eurostile Nebiolo

Geneva Apple Computer, Inc.

GillSans The Monotype Corporation plc

Helvetica Linotype-Hell AG and/or its subsidiaries

Hoefler Jonathan Hoefler Type Foundry

ITC Avant Garde Gothic International Typeface Corporation

ITC Bookman International Typeface Corporation

ITC Mona Lisa International Typeface Corporation

ITC Zapf Chancery International Typeface Corporation

Joanna The Monotype Corporation plc

Marigold Arthur Baker

Monaco Apple Computer, Inc.

New York Apple Computer, Inc.

Oxford Arthur Baker

Palatino Linotype-Hell AG and/or its subsidiaries

Stempel Garamond Linotype-Hell AG and/or its subsidiaries

Taffy Agfa Corporation

Times New Roman The Monotype Corporation plc
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Univers Linotype-Hell AG and/or its subsidiaries

All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Modular component notice

Wireless‑equipped models contain the following modular component(s):

Lexmark Regulatory Type/Model LEX-M01-005; FCC ID:IYLLEXM01005; IC:2376A-M01005

Licensing notices

All licensing notices associated with this product can be viewed from the root directory of the documentation CD.
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Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

Note: Some modes may not apply to your product.

1-meter average sound pressure, dBA

Printing 55 dBA (simplex); 54 dBA (duplex)

Ready N/A

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products.

If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local
sales office phone number.

Product disposal

Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities
for disposal and recycling options.

Taiwan waste dry cell batteries recycle logo notice

According to Article 15 of the Waste Disposal Act in the announcement of Taiwan EPA, the producing or the importing
manufacturer is responsible for recycling, clearance, and disposal of dry cell batteries, batteries packaged with products
and sold, given, and promoted with products to consumers may be labeled with the recycling mark with the remark
"please recycle waste batteries" on the product package, the label, or the product manual. Enclosed please find the
waste dry cell batteries recycle logo with the remark. Please give the waste dry cell batteries to a company who has
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the waste dry cell batteries recycle logo and provides the recycle service in order to have the appropriate process for
the waste dry cell batteries.

Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR

Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Temperature information

Ambient temperature 16 to 32°C (60 to 90°F)

Shipping and storage temperature ‑20 to 40°C (‑4 to 104°F)

Laser notice

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class I
(1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
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and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label

A laser notice label may be affixed to this printer as shown:

DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.

PERIGO - Radiação a laser invisível será liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposição aos feixes de laser.

Opasnost - Nevidljivo lasersko zračenje kada su kasete uklonjene i poništena sigurnosna veza. Izbjegavati izlaganje zracima.

NEBEZPEČÍ - Když jsou vyjmuty kazety a je odblokována pojistka, ze zařízení je vysíláno neviditelné laserové záření. Nevystavujte se působení laserového paprsku.

FARE - Usynlig laserstråling, når patroner fjernes, og spærreanordningen er slået fra. Undgå at blive udsat for laserstrålen.

GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.

DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.

VAARA - Näkymätöntä lasersäteilyä on varottava, kun värikasetit on poistettu ja lukitus on auki. Vältä lasersäteelle altistumista.

GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.

ΚΙΝΔΥΝΟΣ - Έκλυση αόρατης ακτινοβολίας laser κατά την αφαίρεση των κασετών και την απασφάλιση της μανδάλωσης. Αποφεύγετε την έκθεση στην ακτινοβολία laser.

VESZÉLY – Nem látható lézersugárzás fordulhat elő a patronok eltávolításakor és a zárószerkezet felbontásakor. Kerülje a lézersugárnak való kitettséget.

PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare l´esposizione al raggio laser.

FARE – Usynlig laserstråling når kassettene tas ut og sperren er satt ut av spill. Unngå eksponering for laserstrålen.

NIEBEZPIECZEŃSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Należy unikać naświetlenia promieniem lasera.

ОПАСНО! Невидимое лазерное излучение при извлеченных картриджах и снятии блокировки. Избегайте воздействия лазерных лучей.

Pozor – Nebezpečenstvo neviditeľného laserového žiarenia pri odobratých kazetách a odblokovanej poistke. Nevystavujte sa lúčom.

PELIGRO: Se producen radiaciones láser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposición al haz de láser.

FARA – Osynlig laserstrålning när patroner tas ur och spärrmekanismen är upphävd. Undvik exponering för laserstrålen.

危险 - 当移除碳粉盒及互锁失效时会产生看不见的激光辐射，请避免暴露在激光光束下。

危險 - 移除碳粉匣與安全連續開關失效時會產生看不見的雷射輻射。請避免曝露在雷射光束下。

危険 - カートリッジが取り外され、内部ロックが無効になると、見えないレーザー光が放射されます。 このレーザー光に当たらないようにしてください。

Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption
(Watts)

Printing The product is generating hard‑copy output from electronic inputs. 640

Copy The product is generating hard‑copy output from hard‑copy original documents. NA

Scan The product is scanning hard‑copy documents. NA

Ready The product is waiting for a print job. 12

Sleep Mode The product is in a high‑level energy‑saving mode. 5.5

Hibernate The product is in a low‑level energy‑saving mode. 0.5

Off The product is plugged into an electrical outlet, but the power switch is turned off. 0

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.
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Values are subject to change. See www.lexmark.com for current values.

Sleep Mode

This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by lowering
power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged after this product
is not used for a specified period of time, called the Sleep Mode Timeout.

Factory default Sleep Mode Timeout for this product (in minutes): 30

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 120 minutes. Setting
the Sleep Mode Timeout to a low value reduces energy consumption, but may increase the response time of the product.
Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more energy.

Hibernate Mode

This product is designed with an ultra‑low power operating mode called Hibernate mode. When operating in Hibernate
Mode, all other systems and devices are powered down safely.

The Hibernate mode can be entered in any of the following methods:

• Using the Hibernate Timeout

• Using the Schedule Power modes

• Using the Sleep/Hibernate button

Factory default Hibernate Timeout for this product in all countries or regions except for EU countries and
Switzerland

Disabled

Factory default value for this product in EU countries or regions and Switzerland 3 days

The amount of time the printer waits after a job is printed before it enters Hibernate mode can be modified between
one hour and one month.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.
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Avis de conformité aux normes de l’industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2009/125/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energy-
related products.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products

This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation

The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.
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Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Notice to users in the European Union

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, radio
equipment and telecommunications terminal equipment and on the ecodesign of energy-related products.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the
laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use
within certain voltage limits and on radio equipment and telecommunications terminal equipment and on the ecodesign
of energy-related products.

Compliance is indicated by the CE marking.
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Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product may be used in the countries indicated in the table below.

AT BE BG CH CY CZ DE DK EE

EL ES FI FR HR HU IE IS IT

LI LT LU LV MT NL NO PL PT

RO SE SI SK TR UK

Česky Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.
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Malti Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.

Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.

Svenska Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,

LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-
specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts

—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).

If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.

If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.
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Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.

To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.

As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest
version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance

—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
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MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

Patent acknowledgment

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.

The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.
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The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.
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Index
Numerics
250‑sheet tray 

installing  18
550‑sheet tray 

installing  18

Symbols
[x]‑page jam, clear manual feeder.
[25y.xx]  130
[x]‑page jam, clear standard bin.
[20y.xx]  127
[x]‑page jam, open front door.
[20y.xx]  123
[x]‑page jam, open rear door.
[20y.xx]  126
[x]‑page jam, open tray [x].
[24y.xx]  129
[x]‑page jam, remove tray 1 to clear
duplex. [23y.xx]  128

A
accessing the controller board  14
Active NIC menu  62
adjusting printer display
brightness  104
adjusting Sleep mode  102
adjusting toner darkness  48
AppleTalk menu  67
attaching cables  19
available internal options  13
avoiding jams  45
avoiding paper jams  120

C
cables 

Ethernet  19
parallel  19
USB  19

canceling 
print job, from computer  50

canceling a print job 
from a computer  50
from the printer control panel  50

cannot open Embedded Web
Server  173
card stock 

loading, multipurpose feeder  33

tips  40
Cartridge low [88.xy]  132
Cartridge nearly low [88.xy]  132
Cartridge very low, [x] estimated
pages remain [88.xy]  132
Cartridge, imaging unit mismatch
[41.xy]  132
Change [paper source] to [custom
string] load [orientation]  133
Change [paper source] to [custom
type name] load [orientation]  132
Change [paper source] to [paper
size] load [orientation]  133
Change [paper source] to [paper
type] [paper size] load
[orientation]  133
checking an unresponsive
printer  144
checking status of parts and
supplies  119
checking the status of parts and
supplies  119
checking the virtual display 

using the Embedded Web
Server  116

cleaning 
exterior of the printer  108

cleaning the printer  108
Close front door  133
Complex page, some data may not
have printed [39]  133
confidential data 

information on securing  107
confidential jobs 

modifying print settings  117
confidential print jobs 

printing from a Macintosh
computer  49

printing from Windows  49
Confidential Print menu  73
Configuration change, some held
jobs were not restored [57]  133
configuration information 

wireless network  24
configurations 

printer  10
Configure MP menu  56

configuring 
multiple printers  117
supply notifications, imaging

unit  116
supply notifications, maintenance

kit  116
supply notifications, toner

cartridge  116
configuring supply notifications  116
configuring the Universal paper size
settings  28
connecting to a wireless network 

using Personal Identification
Number (PIN) method  26

using Push Button Configuration
(PBC) method  26

using the Embedded Web
Server  26

using wireless setup wizard  25
conservation settings 

brightness, adjusting  104
conserving supplies  100
Eco‑Mode  100
Hibernate mode  102
Hibernate Timeout  103
Quiet mode  101
Schedule Power Modes  104
Sleep mode  102

conserving supplies  100
contacting customer support  175
control panel, printer  11

indicator light  12
Sleep button light  12

controller board 
accessing  14

creating the printer control panel
PIN  118
Custom Names menu  60
custom paper type 

assigning  39
custom paper type name 

creating  38
custom paper type names 

assigning  38
Custom Type [x] 

assigning a paper type  39
Custom Type [x] name 

creating  38
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Custom Types menu  60

D
Default Source menu  53
Defective flash detected [51]  134
device and network settings 

erasing  107
directory list 

printing  50
Disk Wiping menu  75
display troubleshooting 

printer display is blank  145
display, control panel  11
display, printer control panel 

adjusting brightness  104
documents, printing 

from Macintosh  48
from Windows  48

E
Eco‑Mode setting  100
embedded solutions 

erasing  107
Embedded Web Server 

adjusting brightness  104
checking the status of parts  119
checking the status of

supplies  119
copying settings to other

printers  117
modifying confidential print

settings  117
problem accessing  173

Embedded Web Server
Administrator's Guide 

where to find  107
emission
notices  178, 179, 182, 183, 184
envelopes 

loading, multipurpose feeder  33
tips on using  40

environmental settings 
conserving supplies  100
Eco‑Mode  100
Hibernate mode  102
Hibernate Timeout  103
printer display brightness,

adjusting  104
Quiet mode  101
Schedule Power Modes  104
Sleep mode  102

erasing non‑volatile memory  107
erasing volatile memory  107
Error reading USB drive. Remove
USB.  134
Error reading USB hub. Remove
hub.  134
Ethernet network 

preparing to set up for Ethernet
printing  22

Ethernet network setup 
using Macintosh  23
using Windows  23

Ethernet networking 
Macintosh  23
Windows  23

Ethernet port  19
Ethernet setup 

preparing for an  22
exterior of the printer 

cleaning  108

F
factory defaults, restoring  119
FCC notices  178, 183
finding more information about the
printer  8
Finishing menu  89
firmware card  13
Flash Drive menu  85
font sample list 

printing  50

G
General Settings menu  77
green settings 

Eco‑Mode  100
Hibernate mode  102
Hibernate Timeout  103
Quiet mode  101
Schedule Power Modes  104

H
held jobs 

printing from a Macintosh
computer  49

printing from Windows  49
Help menu  98
Hibernate mode 

using  102
Hibernate Timeout 

setting  103

HTML menu  97

I
Image menu  98
imaging unit 

ordering  109
replacing  112

Imaging unit low [84.xy]  134
Imaging unit nearly low [84.xy]  134
Imaging unit very low, [x] estimated
pages remain [84.xy]  134
Incorrect paper size, open [paper
source] [34]  134
indicator light  11
individual settings 

erasing  107
Insert Tray [x]  135
installing an optional card  15
installing printer on a network 

Ethernet networking  23
installing printer software 

adding options  21
installing printer software
(Windows)  20
installing the 250‑sheet tray  18
installing the 550‑sheet tray  18
Insufficient memory for Flash
Memory Defragment operation
[37]  135
Insufficient memory to collate job
[37]  135
Insufficient memory to support
Resource Save feature [35]  135
Insufficient memory, some Held
Jobs were deleted [37]  135
Insufficient memory, some held
jobs will not be restored [37]  136
internal options  13
IPv6 menu  66

J
jams 

accessing  121
avoiding  120
understanding messages  121

jams, clearing 
in duplex area  128
in front door  123
in manual feeder  130
in rear door  126
in standard bin  127
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in tray [x]  129
Job Accounting menu  91

L
labels, paper 

tips on using  41
letterhead 

loading, multipurpose feeder  33
tips on using  41

light, indicator  11
linking trays  37

assigning custom paper type
names  38

Load [paper source] with [custom
string] [orientation]  136
Load [paper source] with [custom
type name] [orientation]  136
Load [paper source] with [paper
size] [orientation]  136
Load [paper source] with [paper
type] [paper size] [orientation]  137
Load Manual Feeder with [custom
string] [orientation]  137
Load Manual Feeder with [custom
type name] [orientation]  137
Load Manual Feeder with [paper
size] [orientation]  137
Load Manual Feeder with [paper
type] [paper size] [orientation]  138
loading 

multipurpose feeder  33
trays  29

loading the optional tray  29
loading the standard tray  29
lock, security  106

M
maintenance kit 

ordering  109
Maintenance kit low [80.xy]  138
Maintenance kit nearly low
[80.xy]  138
Maintenance kit very low, [x]
estimated pages remain
[80.xy]  138
memory 

types installed on printer  106
memory card  13

installing  16
Memory full [38]  138

menu settings 
loading on multiple printers  117

menu settings page 
printing  27

menus 
Active NIC  62
AppleTalk  67
Confidential Print  73
Configure MP  56
Custom Names  60
Custom Types  60
Default Source  53
Disk Wiping  75
Finishing  89
Flash Drive  85
General Settings  77
Help  98
HTML  97
Image  98
IPv6  66
Job Accounting  91
list of  52
Miscellaneous  73
Network [x]  62
Network Card  64
Paper Loading  59
Paper Size/Type  53
Paper Texture  56
Paper Weight  58
Parallel [x]  69
PCL Emul  94
PDF  93
PostScript  94
Quality  90
Reports  61, 64
Security Audit Log  74
Set Date and Time  75
Setup  87
SMTP Setup menu  72
Standard Network  62
Standard USB  68
Substitute Size  56
TCP/IP  65
Universal Setup  61
Utilities  92
Wireless  67
XPS  93

Miscellaneous menu  73
moving the printer  9, 114, 115
multipurpose feeder 

loading  33

N
Network [x] menu  62
Network [x] software error
[54]  138
Network Card menu  64
network setup page 

printing  27
noise emission levels  179
Non‑Lexmark [supply type], see
User’s Guide [33.xy]  139
non‑volatile memory  106

erasing  107
Not enough free space in flash
memory for resources [52]  139
notices  177, 178, 179, 180, 181, 
182, 183, 184, 185
number of remaining pages 

estimate  109

O
optional card 

installing  15
optional tray 

loading  29
options 

250‑sheet tray, installing  18
550‑sheet tray, installing  18
firmware cards  13
memory card  16
memory cards  13
updating in printer driver  21

ordering 
imaging unit  109
maintenance kit  109

ordering supplies 
toner cartridge  109

P
paper 

characteristics  42
letterhead  43
loading, multipurpose feeder  33
preprinted forms  43
recycled  43
selecting  43
setting size  28
setting type  28
storing  45
unacceptable  43
Universal size setting  28
using recycled  100
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paper feed troubleshooting 
message remains after jam is

cleared  148
paper jams 

avoiding  120
paper jams, clearing 

in duplex area  128
in front door  123
in manual feeder  130
in rear door  126
in standard bin  127
in tray [x]  129

paper labels 
loading, multipurpose feeder  33

Paper Loading menu  59
paper messages 

[x]‑page jam, remove tray 1 to
clear duplex. [23y.xx]  128

Paper Size/Type menu  53
paper sizes 

supported by the printer  45
paper stop, using  28
Paper Texture menu  56
paper types 

duplex support  46
supported by printer  46
where to load  46

Paper Weight menu  58
Parallel [x] menu  69
parallel port  19
parts 

checking status  119
checking, using the Embedded

Web Server  119
using genuine Lexmark  108

parts and supplies, status of 
checking, on printer control

panel  119
PCL Emul menu  94
PDF menu  93
Personal Identification Number
method 

using  26
PostScript menu  94
preparing to set up the printer on
an Ethernet network  22
print irregularities  161
print job 

canceling from the printer control
panel  50

canceling, from computer  50

print quality troubleshooting 
blank pages  165
characters have jagged edges  155
clipped pages or images  156
gray background on prints  158
horizontal voids appear on

prints  170
print irregularities  161
print is too dark  162
print is too light  164
printer is printing solid black

pages  167
repeating print defects appear on

prints  162
shadow images appear on

prints  157
skewed print  166
streaked horizontal lines appear

on prints  168
streaked vertical lines  169
toner fog or background

shading  172
toner rubs off  173
toner specks appear on prints  172
transparency print quality is

poor  167
uneven print density  173
white streaks  171

print troubleshooting 
held jobs do not print  151
incorrect characters print  153
incorrect margins on prints  159
jammed pages are not

reprinted  149
job prints from wrong tray  152
job prints on wrong paper  152
jobs do not print  149
Large jobs do not collate  154
multiple‑language PDF files do not

print  149
paper curl  160
paper frequently jams  148
print job takes longer than

expected  152
tray linking does not work  153
unexpected page breaks

occur  154
printer 

basic model  10
minimum clearances  9
moving  9, 114, 115
selecting a location  9

shipping  115
printer configurations  10
printer control panel  11

adjusting brightness  104
factory defaults, restoring  119
indicator light  12
Sleep button light  12
using  11

printer control panel PIN 
creating  118

printer control panel, virtual
display 

using the Embedded Web
Server  116

Printer had to restart. Last job may
be incomplete.  139
printer information 

where to find  8
printer is printing blank pages  165
printer messages 

[x]‑page jam, clear manual feeder.
[25y.xx]  130

[x]‑page jam, clear standard bin.
[20y.xx]  127

[x]‑page jam, open front door.
[20y.xx]  123

[x]‑page jam, open rear door.
[20y.xx]  126

[x]‑page jam, open tray [x].
[24y.xx]  129

Cartridge low [88.xy]  132
Cartridge nearly low [88.xy]  132
Cartridge very low, [x] estimated

pages remain [88.xy]  132
Cartridge, imaging unit mismatch

[41.xy]  132
Change [paper source] to [custom

string] load [orientation]  133
Change [paper source] to [custom

type name] load
[orientation]  132

Change [paper source] to [paper
size] load [orientation]  133

Change [paper source] to [paper
type] [paper size] load
[orientation]  133

Close front door  133
Complex page, some data may not

have printed [39]  133
Configuration change, some held

jobs were not restored [57]  133
Defective flash detected [51]  134
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Error reading USB drive. Remove
USB.  134

Error reading USB hub. Remove
hub.  134

Imaging unit low [84.xy]  134
Imaging unit nearly low

[84.xy]  134
Imaging unit very low, [x]

estimated pages remain
[84.xy]  134

Incorrect paper size, open [paper
source] [34]  134

Insert Tray [x]  135
Insufficient memory for Flash

Memory Defragment operation
[37]  135

Insufficient memory to collate job
[37]  135

Insufficient memory to support
Resource Save feature [35]  135

Insufficient memory, some Held
Jobs were deleted [37]  135

Insufficient memory, some held
jobs will not be restored
[37]  136

Load [paper source] with [custom
string] [orientation]  136

Load [paper source] with [custom
type name] [orientation]  136

Load [paper source] with [paper
size] [orientation]  136

Load [paper source] with [paper
type] [paper size]
[orientation]  137

Load Manual Feeder with [custom
string] [orientation]  137

Load Manual Feeder with [custom
type name] [orientation]  137

Load Manual Feeder with [paper
size] [orientation]  137

Load Manual Feeder with [paper
type] [paper size]
[orientation]  138

Maintenance kit low [80.xy]  138
Maintenance kit nearly low

[80.xy]  138
Maintenance kit very low, [x]

estimated pages remain
[80.xy]  138

Memory full [38]  138
Network [x] software error

[54]  138

Non‑Lexmark [supply type], see
User’s Guide [33.xy]  139

Not enough free space in flash
memory for resources [52]  139

Printer had to restart. Last job
may be incomplete.  139

Reinstall missing or unresponsive
cartridge [31.xy]  140

Reinstall missing or unresponsive
imaging unit [31.xy]  140

Remove paper from standard
output bin  140

Replace cartridge, 0 estimated
pages remain [88.xy]  140

Replace cartridge, printer region
mismatch [42.xy]  140

Replace imaging unit, 0 estimated
pages remain [84.xy]  141

Replace maintenance kit, 0
estimated pages remain
[80.xy]  141

Replace unsupported cartridge
[32.xy]  141

Replace unsupported imaging unit
[32.xy]  141

Serial option [x] error [54]  141
SMTP server not set up. Contact

system administrator.  142, 143
Standard network software error

[54]  142
Standard parallel port disabled

[56]  142
Standard USB port disabled

[56]  142
Too many flash options installed

[58]  142
Too many trays attached [58]  143
Unformatted flash detected

[53]  143
Unsupported option in slot [x]

[55]  143
Unsupported USB hub, please

remove  134
printer options troubleshooting 

internal option is not
detected  146

tray problems  147
printer problems, solving basic  144
printer security 

information on  107
printer software, installing
(Windows)  20

printing 
directory list  50
font sample list  50
from Macintosh  48
from Windows  48
menu settings page  27
network setup page  27

printing a document  48
printing a network setup page  27
printing confidential and other held
jobs 

from a Macintosh computer  49
from Windows  49

publications 
where to find  8

Push Button Configuration method 
using  26

Q
Quality menu  90
Quiet mode  101

R
recycled paper 

using  43, 100
recycling 

Lexmark packaging  105
Lexmark products  105
toner cartridges  105

reducing noise  101
Reinstall missing or unresponsive
cartridge [31.xy]  140
Reinstall missing or unresponsive
imaging unit [31.xy]  140
Remove paper from standard
output bin  140
repeat print jobs 

printing from a Macintosh
computer  49

printing from Windows  49
repeating print defects appear on
prints  162
Replace cartridge, 0 estimated
pages remain [88.xy]  140
Replace cartridge, printer region
mismatch [42.xy]  140
Replace imaging unit, 0 estimated
pages remain [84.xy]  141
Replace maintenance kit, 0
estimated pages remain
[80.xy]  141
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Replace unsupported cartridge
[32.xy]  141
Replace unsupported imaging unit
[32.xy]  141
replacing 

imaging unit  112
toner cartridge  110

reports 
viewing  116

Reports menu  61, 64
reserve print jobs 

printing from a Macintosh
computer  49

printing from Windows  49

S
safety information  6, 7, 179
Schedule Power Modes 

using  104
security 

modifying confidential print
settings  117

Security Audit Log menu  74
security lock  106
security settings 

erasing  107
security Web page 

where to find  107
selecting a location for the
printer  9
selecting paper  43
Serial option [x] error [54]  141
Set Date and Time menu  75
setting 

paper size  28
paper type  28
TCP/IP address  65

setting Hibernate Timeout  103
setting up the printer 

on an Ethernet network
(Macintosh only)  23

on an Ethernet network (Windows
only)  23

Setup menu  87
shipping the printer  115
Sleep mode 

adjusting  102
SMTP server not set up. Contact
system administrator.  142, 143
SMTP Setup menu  72
standard bin, using  28
Standard Network menu  62

Standard network software error
[54]  142
Standard parallel port disabled
[56]  142
standard tray 

loading  29
Standard USB menu  68
Standard USB port disabled
[56]  142
statement of volatility  106
status of parts and supplies 

checking  119
storing 

paper  45
supplies  110

streaked horizontal lines appear on
prints  168
streaked vertical lines appear on
prints  169
streaks appear  171
Substitute Size menu  56
supplies 

checking status  119
checking, using the Embedded

Web Server  119
conserving  100
storing  110
using genuine Lexmark  108
using recycled paper  100

supplies, ordering 
imaging unit  109
maintenance kit  109
toner cartridge  109

supply notifications 
configuring  116

supported paper sizes  45
supported paper types and
weights  46

T
TCP/IP menu  65
tips 

card stock  40
letterhead  41
on using envelopes  40
on using labels  41
transparencies  41

tips on using envelopes  40
toner cartridge 

ordering  109
replacing  110

toner cartridges 
recycling  105

toner darkness 
adjusting  48

Too many flash options installed
[58]  142
Too many trays attached [58]  143
transparencies 

loading, multipurpose feeder  33
tips  41

trays 
linking  37
loading  29
unlinking  37

troubleshooting 
cannot open Embedded Web

Server  173
checking an unresponsive

printer  144
contacting customer support  175
solving basic printer

problems  144
troubleshooting, display 

printer display is blank  145
troubleshooting, paper feed 

message remains after jam is
cleared  148

troubleshooting, print 
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